RosslareBio 9000

Biometric Recognition Management Software
Software Manual

ROSSINR=

SECURITY PRODUCTS



Copyright © 2019 by Rosslare. All rights reserved.

This manual and the information contained herein are proprietary to ROSSLARE ENTERPRISES LIMITED and/or its
related companies and/or subsidiaries’ (hereafter: "ROSSLARE"). Only ROSSLARE and its customers have the right to
use the information.

No part of this manual may be re-produced or transmitted in any form or by any means, electronic or mechanical, for
any purpose, without the express written permission of ROSSLARE.

ROSSLARE owns patents and patent applications, trademarks, copyrights, or other intellectual property rights
covering the subject matter in this manual.

TEXTS, IMAGES, AND ILLUSTRATIONS INCLUDING THEIR ARRANGEMENT IN THIS DOCUMENT ARE SUBJECT TO THE
PROTECTION OF COPYRIGHT LAWS AND OTHER LEGAL RIGHTS WORLDWIDE. THEIR USE, REPRODUCTION, AND
TRANSMITTAL TO THIRD PARTIES WITHOUT EXPRESS WRITTEN PERMISSION MAY RESULT IN LEGAL PROCEEDINGS.

The furnishing of this manual to any party does not give that party or any third party any license to these patents,

trademarks, copyrights or other intellectual property rights, except as expressly provided in any written agreement of
ROSSLARE.

ROSSLARE reserves the right to revise and change this document at any time, without being obliged to announce such
revisions or changes beforehand or after the fact.



RosslareBio 9000 Software Guide 3

Table of Contents

Chapter 1 Getting Started...................ueceuverevvcrevcerrnnn, 6
INtroduction..............iniccccnnee 7
System Configuration..............ioevinreereereereeeeececeeennes 8
Specification ............... e 9
System Environment..................eoeeerreceeceeceeeeeeeeneens 10
Scanning Fingerprints............ieninneeneneeneecreeseenne 12
Authentication Method.....................cuvirriinnncnnnnnne. 13

Chapter 2 Installing Bio9000 Professional................... 15
Installing SQL EXPress...........uioeveenveeneeeeeneeneeseeseesaeene 16
Configuring SQL EXPIress...........ccoeveeveereerreeseeeseeseeesaesaees 23
Installing Bio9000 ..............oooeeieeereeeeereeeeereeseeseeseesnene 37

Chapter 3 Basic Configuration and Administrator
ReGiStration...................eeeeeeeeeeeeeeeeeeeeeeeee e 45
Basic Configuration and Administrator Registration

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 4
Menu Layout and ICONS............eoeeeeeerereceeeceeceeerenenne 60
Managing USErS...........ioeeeeeereeeeeneeeeesneeseesneessesseesanns 65
Managing GroUPS............cceeeeeeveereeereeseeeseesseeseesseesseseesaeans 84
Managing Position ..............civineeieeeececeeceeeeceeeene 920
ManNaging ACCESS ..........ccueereeeeeeeereeereesaeeseesseessesseessessaesaasns 91
Managing Terminals............cooovieveneenenreereeneereeceesaene 93
Managing Authentication Log ............cccoceveeerveeeennen. 134
Managing System Log...........cccuvevenreerenceennecreeneeeseennens 137
Managing privilege............ o rereeeeeeeeeceeeeeeeeeenees 139
T&A Management................oeieeeceerceenerecneecneesesesnnenns 145
Setting OpLions.......... e nes 146
Setting Time Zone ... eeeeeeeeceeceeeeseeeecaeeeeenes 156
Setting APB ............. et eenes 162
Downloading Logo/Wallpaper .............ccuveeveeveeeennen. 170
Downloading Firmware............eeeveeceeceereereeeseennens 172
Log Management...............oierernreeccrecneeneecenecneenaeens 173

ROSSINR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 5

User Restore............eccccncencnceescnescncannns 175
Door Control ... 176
Synchronization............... et 177
General Synchronization.................eoeeeeecceecceeeeenne 179
MONIEOFING.......o ettt seeseesee e saeeeesaees 180
LOLL TN 2 (5T o o o 182
EXPOFt USEK ..........oeeeeeeceeeeeerereeeeseeeessnesesneeesnnsessnens 184
IMPOIT USEE .......eeeeeeeeeeeeetereeeeseeeesnesesnesesanaeesaneennns 186
IMPOrt LOQ ... eeeeeeeeeeceecceeeceeceeeseeesseesneeasesasesnns 187
Setup Wiegand...............oeeveeeeeeceereeeeecneeeesneeeennes 190
Chapter 5 Appendix...............ueeeeeeeeeeeseernnsssessnnsssssnns 195
FAQ oo eemeeeeeesseemeseemssseemsssseesesmssseesesssssemmesesessseenes 196
ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 6

Chapter 1
Getting Started
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Introduction

Biometrics systems are becoming increasingly convenient and affordable,
causing their use to expand beyond the usual high security locations.
Among biometrics systems, fingerprint recognition systems are most
widely used because they are easy to use, affordable, and can support
various applications. Rosslare, a leader in the fingerprint recognition
industry, provides various fingerprint solutions including computer
security, knowledge management, access control, vault security,
electronic transaction settlements, and financial settlements. The
company responds to evolving customer demands through continuous
R&D and quality management.

Rosslare’s access control system integrates the company’s core
technologies such as fingerprint recognition algorithms, optical sensors,
embedded design, and software application technology. Unlike access,
control systems, which only use passwords, or ID cards, Rosslare’s
fingerprint system prevents the possibility of lost passwords, card
forgery, or card robbery. Instead of having terminals operate
independently, the system remotely monitors terminals in network
format, resulting in improved efficiency.

Rosslare’s access control system supports RF cards, passwords, and
fingerprint recognition and provides features such as group ID, shortcut
ID, and 1: N matching, as well an interphone and voice instructions to
satisfy the needs of various customers.

This guide describes how to use the high-capacity access server and
remote manager.
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System Configuration

m Network configuration

"f—ﬂ

K 1!15

T

Item Major Functions

S/W: Access Server, remote manager
(Bio9000)

User Central terminal control and management
Authentication

Server PC

S/W: remote manager (Bio9000)
Client PC User registration and management
Terminal status and event monitoring
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Specification

Item Description
Terminal Up to 500 terminals can be connected.

Sixteen programs can connect to the access
server at the same time.

Registered users | 100,000

Programs

Initial values are shown below.
- Maximum connection of terminals: 500
- Maximum connection of management programs: 16

/ ,Large size of system memory would be required to
—support many number of connections. Therefore,
proper maximum connection count should be
configured to manage Bio9000 efficiently.

Jf maximum connection count was exceeded maximum
~value or configured to zero, this value will be
configured to initial value.
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System Environment

m Server System (AccessServer)

Item Description

0S XP/2003/VISTA/7/10/2008

Minimum: Pentium IV 2 GHz or higher

cPu Recommended: Core 2 Duo E8400 3GHz or higher

Minimum: 1GB (With 400 MB free memory)

Memory | pecommended: 3GB (With 1GB free memory)

Hard Disk | Minimum 5 GB free memory

MS SQL Express 2005(Windows 2000 Professional,
XP Professional, VISTA)

Database | MS SQL Server 2005 & 2008(Windows 2000 Server,
2000 Advanced Server, Server 2003, Windows 7)
Oracle 9i, 10g (To be supported)

-

BYOU can use the MS SQL Express version as the
—database but Rosslare will bear no financial or

legal responsibilities. For greater reliability and
stability, please purchase MS SQL Server standard
version.
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m Client System (Bio9000 / Monitoring)

Item Description
oS XP/2003/VISTA/7/10/2008
CPU Minimum: Pentium IV 1GHz or higher
Recommended: Core2 Duo or higher
Memory Minimum: 1GB
Hard Disk Minimum 1 GB of free memory

m Terminal (Access Controller)

o AY-B91x0BT
« AY-B9350

m Fingerprint Reader (USB Type)
To authenticate the administrator’s fingerprints or to register the user’s

fingerprints at a PC, a Rosslare fingerprint recognition mouse or hamster
must be installed.
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Scanning Fingerprints

Scan the fingerprint as described below to prevent errors in fingerprint
registration or authentication.

(1) Maximize the area scanned and apply pressure evenly (50
to 70% of full pressure).

‘A N°
X o

(2) Place the ( core ) of the fingerprint at the center of the scanner.
The core is usually opposite the whitish half-moon at the bottom of
the fingernail. Therefore, place the half-moon part at the center of
the scanner when scanning.

| iThe scanner’s performance depends greatly on
%e user. Users should practice and use the
scanning method above for best results.
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Authentication Method

The access control system can conduct authentication using passwords
and RF cards (optional). The administrator can select one of the
following authentication methods to fit the client’s environment.

m Fingerprint Authentication

The following fingerprint authentication modes are available.

(D 1:1 Authentication

The user inputs a registered ID and scans his fingerprint. The

system will compare the scanned fingerprint and the fingerprint

registered for the ID. This method enables fast authentication.
(2 1:N Authentication
The user scans his fingerprint without inputting an ID. This
process is simple but authentication may take longer than the
1:1 method if there are a lot of users.
(3) Shortcut ID (SID) Authentication
The user inputs only part of his ID and scans a fingerprint that
was already registered. This process is simple but

authentication may take longer than the 1:1 method if there
are a lot of users.
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(4) Group Authentication

A one to four digit group ID is given to each group. To
authenticate, the user enters the group ID and scans his
fingerprint. For example, apartment residents can use the room
number as the group ID. The group ID can be set during user
registration.

m Password Authentication (Except the model has no keypad)

The user inputs 4 to 8 digit numeric password without scanning a
fingerprint. This method is useful in special situations (when the
fingerprint is damaged, etc).

m RF Card Authentication (optional)

Users are identified by their RF cards. The RF card numbers must first
be registered at the system.

m Face Authentication

It is a method of confirmation of an identity through the face of user. It
is available through the registration only at the particular terminal at
which the face authentication is available.

m BLE-ID mobile Authentication
It is a method of confirmation of an identity through the mobile phone

app of user. Refer to the APP-x411 BLE-ID App Installation and User
Manual.
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Chapter 2

Installing
Bio9000
Professional
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Installing SQL Express

This section describes how to install SQL Express, which can be used as
the basic database of Bio9000.

(1) Start the executable file of SQL Express. Accept the license
agreement and click [Next].

¥ Microsoft SQL Server 2005 Setup @

End User License Agreement

MICROSOFT SOFTWARE LICENSE TERMS ~

MICROSOFT SQL SERVER 2005 EXPRESS EDITION WITH
ADVANCED SERVICES

These license terms are an agreement between
Microsoft Corporation (or based on where you
live, one of its affiliates) and you. Please
read them. They apply to the software named
above, which includes the media on which you
received it, if any. The terms also apply to any
Microsoft

* uypdates,
* supplenents,
* Internet-based services, and

* support services v

¥ | accept the licensing terms and conditions

Print Cancel

«NETFramework 2.0 must be installed on the

~system before SQL Express is installed.
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(2) Click [Install] and install the essential components.

P Microsoft SQL Server 2005 Setup @

Installing Prerequisites

Installs software components required prior to installing SGL
Server,

SQL Server Component Update will install the following components
required for SQL Server Setup:

Microsoft SQL Native Client
Microsoft SQL Server 2005 Setup Support Files

Click Install to continue.

Install | Cancel |

(3) After installing the components, click [Next] to proceed with
the installation.

P Microsoft SQL Server 2005 Setup ®

Installing Prerequisites

Installs software components required prior to installing SOL
Server.

SQL Server Component Update will install the following components
required for SQL Server Setup:

¥ Microsoft SQL Mative Client
¥ Microsoft SQL Server 2005 Setup Suppart Files

The required components were installed successfully.

Next > I |
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(@) Click [Next] and start the Installation Wizard for Microsoft
SQL Server.

16! Microsoft SOL Server 2005 Setup @

» Welcome to the Microsoft SQL
Server Installation Wizard

Setup will help you install, modify or remove Microsoft
SOL Server. To continue, click Next.

¥ 4

| Next > I Cancel |

(5) After the system configuration check is completed, click
[Next].

16! Microsoft SOL Server 2005 Setup E]

System Configuration Check
‘Wait while the system is checked for potential installation
problems.
i
15 Total 0 Eror
’ @ Huccess 14 Success 1 Warning
Details:
| Action | Status I Message »
@ Pending Reboot Requirement Success
@ Performance Monitor Counter Require...  Success
@ Default Installation Path Permission Re...  Success
@ Intemet Explorer Requirement Success
@ COM Plus Catalog Requirement Success
@ ASP.NetVersion Registration Require...  Success
@ Minimum MDAC Version Requirement Success
@ Edition Change Check Success -
v
Fiter = | Repot  w |
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(6) Input the registration information and click [Next].

(7) Select the components to install as shown below, and click
[Next].

& Microsoft SOL Server 2005 Setup @

Feature Selection
Select the program Features you want installed.

- |
Click an icon in the following list to change how a feature is installed.
= = Feature description
‘% )| Database Services Installs interactive management tools
= =3 ~| Client Components for running SQL Server, including SQL
=3 v | Connectivity Components Server Management Studio Express.

X_~| Software Development Kit

112 bytes on
X  Entire feature will be unavailable

Installation path

[ < Back ] I Next > I [ Cancel l
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Select [Mixed Mode]. Enter the password and click [Next].

& Microsoft SQL Server 2005 Setup @

Authentication Mode
The authentication mode specifies the security used when
connecting to SQL Server.,

Select the authentication mode to use for this installation.

O windows Authentication Mode

(® Mixed Mode (Windows Authentication and SQL Server Authentication)

Specify the sa logon password below:

Enter password:
|uw*

Confirm password:
lw*w

[ < Back ]I Next > ][ Cancel l

(9) Click [Next] on the Error and Usage Report Settings window.

& Microsoft SQL Server 2005 Setup @

Error and Usage Report Settings

Help Microsoft improve some of the SQL Server 2005 components
and services.

Automatically send Error reports for SQL Server 2005 to Microsoft or your corporate error

Drepovting server, Error reports include information regarding the condition of SQL Server
2005 when an error occurred, your hardware configuration and other data, Error reports
may unintentionally include personal information, which will not be used by Microsoft.

Automatically send Feature Usage data for SQL Server 2005 to Microsoft, Usage data
includes anonymous information about your hardware configuration and how you use our
software and services.

By installing Microsoft SQL Server 2005, SQL Server and its components will be configured to
automatically send fatal service error reports to Microsoft or a Corporate Error Reporting
Server. Microsoft uses error reports to improve SQL Server functionality, and treats all
information as confidential,

[ < Back ] [ Next > ] [ Cancel I
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Click [Install] on the Ready to install window.

& Microsoft SOL Server 2005 Setup @
Ready to Install
Setup is ready to begin installation.
|
Setup has enough information to start copying the program files, To proceed, click Install. To
change any of your installation settings, click Back. To exit setup, click Cancel.

IThe following components will be installed:

. SQL Server Database Services

(Database Services)

e  Client Components

(Connectivity Components, Management Studio Express)

[ < Back ]I Install ][ Cancel )

(1)) After the selected components are installed, click [Next].

™ Microsoft SQL Server 2005 Setup @

Setup Progress
The selected components are being configured

Product Status

(D msxme Setup finished
L;’/)SQL Setup Support Files Setup finished
(250 v55 writer Setup finished
@SQL Server Database Services Setup finished

@SQL Server Management Studio Express  Setup finished
@Workstation Components, Books Onlin... Setup finished

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide

(12) After SQL Express is installed, click [Fi

¥ Microsoft SQL Server 2005 Setup

Completing Microsoft SQL Server 2005 Setup
Setup has finished configuration of Microsoft SQL Server 2005

ish].

Refer to the setup error logs For information describing any failure(s) that occurred during
setup. Click Finish to exit the installation wizard.

Summary Log
To minimize the server surface area of SQL Server 2005, some features and services are

disabled by default For new installations. To configure the surface area of SQL Server, use the

Surface Area Configuration tool.

Configuring and Managing SQL Server »
Express
+  Forimproved manageability and security, SQL

Server 2005 provides more control over the SQL

Server surface area on your system. To minimize

the surface area, the following default

configurations have been applied to your

instance of SQL server:

o TCPIP connections are disabled

- Mavnnd Dinan in Ainahlad

Help Finish

v
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Configuring SQL Express

This section describes how to configure SQL Express so that Bio9000
and the SQL Express database can work together.

(D) Click the Windows [Start] button and select [Run]. Then,
execute the [emd] command as shown below.

Run @

- Type the name of a program, folder, document, or
Internet resource, and Windows will open it for you.

[ oK ][ Cancel ][ Browse. .. ]

(2) Execute the [ipconfig] command and write down the [IP
Address] on paper or notepad.
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(3) Click the Windows [Start] button and select [SQL Server
Configuration Manager] as shown below.

e Windows Media Playsiill

[ NVIDIA Corporation M| 22 sqL server Studio Express ] SQL Server Error and Usage Reporting

“3 Windows Messenger | () Startup 3 \I &i] SQL Server Surface Area Configuration
@ Internet Explorer
@ Tour Windows XP ) v
é@ Files and Settings Trd| (G) Outlook Express
Wizard

. Remote Assistance
i Microsoft Office wor|| @ Windows Media Player

4% windows Messenger

) Windows Movie Maker

(4) After starting SQL Server Configuration Manager, click [SQL
Server 2005 Network Configuration > SQL EXPRESS
Protocol]. On the right side of the window, click [Named
Pipe] and [Properties].

7 SOL Server. Configuration Manager Q@@

File Action View Help

e A EFR R

[ 5QL server Configuration Manager (Local) Protocol Name. [ Status [
SQL Server 2005 Services S shared Memory Enabled
= 5. 5QL Server 2005 Network Configuration
& Protocols for SQLEXPRESS TR Enable
5} SQL Native Client Configuration VA
Help

(Opens property sheet For the current selection.
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(5) In the Named Pipes Properties window click [Enabled] >
[Yes] and click [Apply].

Named Pipes Properties @

Protocol

=]

Mo

Enabled
Enable or disable Named Pipes protocol For this server instance

(6) A warning message will appear as shown below. Click [OK]
and close the Named Pipes Properties window.

°
1 ) Any changes made will be saved; however, they will not take effect until the service is stopped and restarted.
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(@) As shown below, click [TCP/IP] and [Properties].

%7 SOL Server Configuration Manager

File Action View Help

e B FR 2

({8 5QL Server Configuration Manager (Local) [ status [
E SQL Server 2005 Services %~ shared Memory Enabled
= 5. 5QL Server 2005 Network Configuration ¥ Named Pipes. Enabled
- Protocols for SQLEXPRESS
8 QL Native Client Configuration ¥vIA Enable
| _Properties |
Help

Opens property sheet for the current selection.

In the Protocol window, click [Enabled] - [Yes] and click

[Applyl.

TCP/IP Properties

Protocol | 1P Addresses
=]
Enabled No
Keep e N
Listen All No
Mo Delay Mo
Enabled
Enable or disable TCP{IP protocol for this server instance
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(9) In the IP1 index of IP Addresses window, click [Enabled]
- [Yes] and put your computer’s IP Address that a recorded
IP Address in step 2 to the IP Address space and click [Apply].

TCP/IP Properties 33

Protocol | IP Addresses ‘
[ = |
Active es
Enabled Yes
1P Address 172.16.0.106 |
TCP Dynamic Parts 0
TCP Port [
Bl 1 |
Active es
Enabled No [
IP Address 127.0.0.1 [
TCP Dynamic Ports 0
TCP Port |
Bl 1ps i
TCP Dynamic Ports 1414 |
TCP Port |
[
IP Address ‘
1P address
[ OK ] [ Cancel ] [ Apply ] [ Help ]

A warning message will appear as shown below. Click [OK]
and close the TCP/IP Properties window.

.
1 ) Any changes made will be saved; however, they will not take effect until the service is stopped and restarted.
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(1)) After applying all changes, go to SQL Server 2005 Services,
and restart the SQL Server Browser and SQL Server
(SQLEXPRESS) as shown below.

Click [SQL Server Browser] and then [Properties].

%7 SOL Server Configuration Manager

Fle Action View Help
e @
({8 5QL Server Configuration Manager (Local)

SQL Server 2005 Services
5QL Server 2005 Network Configuration

- Protocols for SQLEXPRESS
5} SQL Native Client Configuration

Help

Opens property sheet for the current selection.
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Go to the Service tab on the SQL Server Browser Properties
window, and click [Start Mode] and [Automatic]. Then click

[Applyl.

SQL Server Browser Properties @@

Log On‘\ Service iAdvanced

=]

[Sertrioge
«
Disabled
Manual

Start Mode
The start mode of this service.

OK ][ Cancel ][ Apply ][ Help ]

After changing the Start Mode option, click [Start Service] as
shown below to restart the SQL Server Browser.

%7 SOL Server Configuration Manager EER
Fie Acion View Help
e 2 ®
({8 5QL Server Configuration Manager (Local) Name State. Start Mode Log On As
SQL Server 2005 Services e NT AUTHO
4. 5oL server 2005 Network Configuration ZosaL e AiFomat NT AUTHOR

¢ Protocols for SQLEXPRESS
5 SQL Native Clisnt Configuration
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Select [SQL Server (SQLEXPRESS)] and restart the SQL
Server (SQL Express) by clicking [Restart] as shown below.

EEX

&7 SQL Server Configuration Manager
Fle Action View Help
& 2 [OJOX}
({8 5QL Server Configuration Manager (Local) State [ start Mode. Log On As
SQL Server 205 Services Automatic NT AUTHOR|
4. 5QL server 2005 Network Configuration 5 AEoAE NT ALTHOR
¢ Protocols for SQLEXPRESS
5} QL Native Client Configuration Stop
Pause
Properties
Help
< >
Restart (stop and then start) selected service.
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(12) Check the basic configuration of SQL Server 2005 (SQL
Express).

Click the Windows [Start] button and select [SQL Server
Management Studio Express] as shown below.

® Windows Media Play M@ Microsoft SQL Server 2005 (A ) Configuration Tools

¢@ MNVIDIA Corporation » l\-. SQL Server Management Studio Express
“\3 Windows Messenger | () Startup »

& Internet Explarer
@ Tour Windows XP sy

@) Files and Settings Tr ) Outlook Express
Weard ¢ Remote Assistance

‘ﬁ SQL Server Confiqurll &) windows Media Player

Manager

4 windows Messenger

UL TEUIEN A 6 windows Movie Maker

Enter the login and password for the SA account configured
when SQL Server 2005 (SQL Express) was installed. Then click

[Connect].

Microsoft A Windows Server System

SQL Server 2005
Server name: |C1 EXPRONASOLEXPRESS v ‘
Authentication: ‘ SQL Server Authentication v l
Login: isa vl
Password: ‘ i |

[[] Remember password

[ Connect I [ Cancel ] [ Help ] [ Options >> ]

If login is failed, please follow the step 15. And try again.
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@) In the SQL Server Management Studio Express window, go
to [Security 2 Login 2 sa account], and click
[Properties].

. Microsoft SOL Server Management Studio Express
Fie Edt View Took Window Community Hep
Qnewauery [y 5 A @ B EBES

Object Explorer Summary =i
Y= 2 2 A& 7 [EEust)
= | CIEXPRONSQUEXPRESS (SQU Server 9.0.2047 - 5a)
% [ Databases i
= [ Secuity lJ sa
= [ Logis CIEXPROM|SQUEXPRESS|Securiy|Loginsisa 0 Ren(s)
8 BUILTIMAdinistrators
8 BUILTINJsers
] CLEXPRONISQUServer200SMEFTEUser§CIEXPRON | | Name
] CIEXPRON|SQUServer200MSSQUUser §C1EXPRON
A NT AUTHORITASYSTEM
@ [ Serves  Newloon.
% (3 credsy Stlognas
® [ Serverob  pename
® [ Roplatior D
# [ Managemr
Refrosh
< >
< >
Ready
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In the [Login Properties — sa] window, click [General] then
[Status]. Check that the settings are the same as below, and

click [OK].

Properties - sa

S seript ~ I Help
& Server Roles
& User Mapping Login name: sa
2 Status
Password:
C
Enforce password policy
[] Enforce password expiation
Certicate name:
— Key name:
Server
CIEXPRON\SOLEXPRESS
) Defaul database: master v
Connection:
Defaul language: Englsh v
3 View connection propertes
Ready

Properties - sa
Sele » o
Script ~ Hel
2 General &5 seint ~ [ Helo
(2 Server Roles
User Mapping Settings

Permission to connect to database engine:
@® Grant
O Deny
Login:
@® Enabled
O Disabled

Status

SOL Server authentication:

Server.
CI1EXPRONASOLEXPRESS

Connection:
3 View connection properties

Progress.
Ready
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In the SQL Server Management Studio Express window,

click [SQLEXPRESS (SQL Server)] as shown below. Then
click [Properties].

£ Microsoft SOL Server Management Studio Express

File Edt View Tools Window Community Help

Qienoay 0y G S B ABES

Object Explorer

 Summary | - x
—| N 4
L Connect...
e Disconnect | ] C1EXPRON\SQLEXPRESS (SQL Server 9.0.2047 - sa)
% (1 Server Objects Regetar:s CIEXPROM|SQLEXPRESS 5 Item(s)
® [ Replication New Query
% (3 Management
Name
0P [ Databases
Pause [asecurty
(3 Server Objects
Restart [AReplcation
[aManagement

Ready
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Click [Security] on the Server Properties window. Check that
the settings are the same as below, and click [OK] to finish
configuration.

F Server Properties - C1EXPRON\SQLEXPRESS

&4 General
2 Memory
A Processors
= ty
27 Connections

%" Database Settings
27 Advanced

24 Pemissions

1

Server:
C1EXPRONASOLEXPRESS

Connection:
sa

3 View connection properties

,S Script ~ L‘j Help

Server authentication

O Windows Authentication mode:
(® SOL Server and Windows Authentication mode

Login auditing
O None
(® Failed logins only
O Successful logins only
O Both failed and successful logins
Server prowy account

[[] Enable server prozy account

Options

[] Enable C2 audit tracing

[] Cross database ownership chaining
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(15 For inspection, execute the SQL Server Management Studio
Express in common with step 11. And log-on by new server
name made with IP Address as shown below.

(If the instance name exists, you should enter ‘IP

address\instance name’.

£¥ Connect to Server @

Microsoft: 2 Windows Server System
SQL Server 2005

Server name: ‘ 172.16.0.106WSALEXPRESS vﬁ‘

Authentication: E:QL Server Authentication v__‘

Loain: isa v ‘

Password: [ ‘

[] Remember password
l Connect l [ Cancel ] [ Help l [ Options >> ]

If log-in is succeeded, all set-ups are done about SQL server.
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Installing Bio9000

This section describes how to install Bio9000 for the Access Server.

Double-click [setup.exe] in the installation package of Bio9000 to
start the installation.

When the installation process is started, the Installation Wizard for
the Bio9000 will appear. Click [Next].

RosslareBic9000 - InstallShield Wizard (==

Welcome to the InstallShield Wizard for
RosslareBio9000

The InstallShield Wizard will install RosslareBio3000 on
your computer. To continue, dlick Next.
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Read the license agreement and accept its terms. Then click [Next].

RosslareBio9000 - InstallShield Wizard

License Agreement
Please read the following license agreement carefully.

ROSSLARE END USER LICENSE AGREEMENT
Last Updated: 03ul2018

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT CAREFULLY BEFORE
[DOWNLOADING OR USING THE SOFTWARE.

BY CLICKING ON THE "ACCEPT" BUTTON, DOWNLOADING THE PRODUCT, OR USING
THE EQUIPMENT THAT UTILIZES THIS PRODUCT, YOU (1) REPRESENT THAT YOU ARE
(OF THE LEGAL AGE OF MAJORITY IN YOUR STATE, PROVINCE, JURISDICTION OF
RESIDENCE AND, IF APPLICABLE, YOU ARE DULY AUTHORIZED TO ENTER INTO THIS
CONTRACT AND (2) YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF
YOU DO NOT AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, CLICK THE

") Ido not accept the terms of the license agreement

©) I accept the terms of the license agreement

[ < Back ” Next > ][ Cancel

Enter the user information and serial number, and click [Next].

RosslareBio9000 - InstallShield Wizard

Customer Information
Please enter your information.

User Name:

user

Company Name:

-

Please enter your name, the name of the company for which you work and the product
serial number.

rosslare

Serial Number:

010301-BDBSEED54D8C0ADA-D1A759391E116FD5

[ < Back ][ Next >

] [ Cancel
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Then, select the path that the program is installed in and select
[Next].

RosslareBio9000 - InstallShield Wizard (=34

Choose Destination Location
Select folder where setup will install files.

Setup will install RosslareBio9000 in the following folder.

To install to this folder, dlick Next. To install to a different folder, dick Browse and select
another folder.

Destination Folder

C:\Program Files\RosslareBio9000

< Back H Next > ][ Cancel ]

Select the functions to install and click [Next]. As these instructions
explains based of Access Server and select [Access Server].

Access Server (Complete) — Both Access Server and Bio9000 (a
remote management program) will be installed.

Bio9000 (Compact) — Access Server is not installed but only Bio9000
(a remote management program) is installed.
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RosslareBio9000 - InstallShield Wizard

Setup Type
Select the setup type to install.

=

Please select a setup type.

@ Complete
.:: RosslareBio%000 Server (with RosslareBio%000)

Itinstalls the server and remote management tools.

() Compact
.:: RosslareBio9000

Itinstalls remote management tools.

[ <Back M Next > ][ Cancel }

After installation, the following screen appears.
Total Biometric Soluﬁ@

01. DataBase Setting

© DBMS Type

@wssaL Olocabs

<q  DBMS Connect Information

@search

O user Input
P «Port o Instance

o Auth Type
(@ SQL Server Authentication

O Windows Authentication

D /Password
sa

* DataBase Path
C:¥fProgram FiesWiicrosoft SQL Server 2]

Cancel

® DBMS Type — Select DB type to connect.

® DBMS Connect information — Set the DB information to connect.
Click Search button to search DB connected to the current

network. Or enter it manually.
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@ Auth Type — Enter DB administrator account information. (You
should enter the admin information, which have the authority for
SA (System Admin) of DB.)

@ DataBase Path — Enter the path where the DB will be saved. You
can automatically search or type directly into Search.

After completing the settings, click the [Next]. button.

If a database already exists, a warning window will appear as shown
below. Select [Yes] or [No] depending on whether the existing
database will be used.

SetupConfig

have a DB in use.
1\ Would you like to reuse it?

ERED

If [Yes] is selected, the exiting database will be used.
If [No] is selected, the existing database will be deleted.
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02. Connect Setting

4 o Core Count
o TMServer .
3 192.168.30.64
o Feature Count
«RMPort E)

NSearch Setting
o Nsearch

v [samsmer | @use Ototuse

7331 o Search Level

*TMPort

optanseting

o = QOuse @notuse

 MAX Client « MobileCard

T S— Ouse @nNotUse

Prev Next OK Cancel

After the database installation, the corresponding screen appears.

RM Server IP — Set the server IP to connect to Remote
Manager
TM Server IP — Set the server IP to connect to Terminal

RM Port — Set the Remote Manager Port
TM Port — Set the Terminal Port

Max Terminal Count — Set the maximum number of terminals
connected to that server. (200 ~ 2000)

Max Client Count — Set the maximum number of Client
connected to that server. (8 ~ 16)

NSearch Use — It determines whether 1: N authentication is
used or not. (If you have more users, it may slow down the
server.
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@ Server Auth — Select when using MAS, which is the matching
server program of Rosslare.

® Mobile Card — Select when you use the mobile card
authentication.

Alf you are not sure about these settings, we
—“recommend using the default values.

AServer connection settings can be set again by
“running SetupConfig.exe after installation is
completed.
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After the necessary files are installed, an installation completion
window will appear. Click [Finish].

RosslareBio9000 - InstallShield Wizard

InstallShield Wizard Complete

The InstaliShield Wizard has successfully installed
RosslareBio9000. Click Finish to exit the wizard.

< Back Finish Cancel

After installing Access Server, the service is automatically registered
and started.

When starting manually, not automatically, from Windows Service
administrator (Window key + R > “services.msc” > [Enter]),
select [Access Server Service] > Start the service.
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Chapter 3

Basic Configuration and
Administrator Registration
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Basic Configuration and Administrator Registration

m Overview

Bio9000 is an access control management program that consists
of Access Server (server program) and Bio9000 (client program).

Bio9000 can be used on the same PC as Access Server or can be
installed on a remote PC connected to a network.

(1) Access Server

Access Server communicates with the administrator programs at
the terminal and remote locations, and manages the user and
event log databases. In Server Authorization mode, Access
Server conducts fingerprint authentication. The administrator
cannot directly manage the server, which can only be accessed
and managed through the Bio9000 program.

Access Server is registered as a Windows service and operates in
background mode even when the system is logged off.

(2) Bio9000
Bio9000 is an administrator program that can connect to the

server and manage databases, and connect to the server and
network to control and manage access control terminals.
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m Basic Setting and Execution
(1) Access Server Execution and Information
o Execution

After installing the program, Access Server is registered in
Windows Service and the user can start it directly.

Click [Access Server Service] and [Start].

*4 Services EEX

Fle Action View Help
|m 2 omum
[ Services (Local) ¥ Sarvices (ocal)

AccessServer Service jame | Description | status | StartupType [ Logonas | a
4 NET Runtime Optimiza... Microsoft .NET Framework NGEN Manual Local System

%E"’li service % Maniage access control server Started  Automatic

[Tttt S dlerter Notifies selected users and comp... Disabled Local Service
@y application Layer Gate... Provides support for 3rd party p... Started  Manual Local Service

- se.. Manual Local System

escription: & oy

Moo oo covtrel server ASP.NET State Service  Provides support for out-of-proc... Manual Network s...
B Automatic Updates Enables the download and install... Started  Automatic Local System
“yBackground Inteligent ... Transfers data between clients ...~ Started  Manual Local System
¥ ClipBook Enables ClipBock Viewer to store... Disabled Lacal System
SCOM+ Event System  Supports System Event Notificati... Started  Manual Local System
484 COM+ System Appiicat... Manages the configuration andt... Started  Manual Local System
& Computer Browser Maintains an updated list of com... Started  Automatic Local System
Sy Cryptographic Services  Provides three management ser... Started  Automatic Local System
“B4DCOM Server Process ... Provides launch functionalty for ... Started  Automatic Local System
S DHCP Client Manages network configur: Automatic Local System 2

Extended A Standard

¢ Information

After Access Server is executed, an icon will appear on the
Windows tray as shown below. But, icon will not appear on the
Windows Vista / 7 / 2008 Server.
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Double-click the Access Server icon to open the Access Server
information window. Click [Hide] to close the window.

AccessServer Manager X
Server Info
Server RM IP| wonki_dev
Server TM IPI wonki_dev
RM Port |733l

Terminal Port | 7332

Version |v 1.0.11.4
DB Info

Instance I
DEIP | 192.168.10.130

Client Info
RM I 1 I 16
Terminal I 1 I 2000

Server Running
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IP address of the Access Server

Server RMIP | 16 connection the Bio9000)
IP address of the Access Server
Server TM 1P (To Connection the Terminal)
Server Info RM Port Communication port for Bio9000
Program
Terminal Port Communication port for the
terminal
Version Version of the Access Server
Database | Instance DBMS instance name
Info Database IP | IP address of the database server
Number of currently connected
RM Bio9000 programs / Maximum
number of Remote Manager
Client Info programs
Number of currently connected
Terminal terminals / Maximum number of

terminals

(2) Reconfiguring Network for Bio9000

If Bio9000 fails to connect to Access Server or is being
executed in a remote place for the first time, the network must
be reconfigured.
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Connect to server successfully.
Please input user information.

This menu is available administrator only. If you keep
the blank password and press '0K', you can
authenticate by fingerprint.

ServerIP: 192.168.10.127

UserID :

Password :

[ Setting ][ 0K ][ Cancel ]

Click [Setting] and a window for entering AccessServer’s
network address will appear as shown below.

Server Settings m

Input the Server Information for Connection

Server IP 192.168.10.127
Port lmi

Wating Time |25
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Server IP Enter the IP address of Access Server.
Communication port for Access Server. To
Communication | change the port value, the port value in
port Access Server must also be changed.
(default: 7331)
Enter the network standby time when
connecting to Access Server. If this value is
exceeded, no more connection attempts will
be made.

Standby Time

Enter the correct values and click [OK] to finish configuration.

AT he Bio9000 program can function only while
“AccessServer is operating. Start AccessServer

before using Bio9000.

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 52

(3) Bi0o9000 Execution and Configuration

When Bio9000 is first executed, the following window will appear.

m Set the terminal type

You can set the terminal to use depending on your environment.

AY-B9350 is the default choice; AY-B91x0BT can be selected
optionally.

m [nitial setting

The initial setting value should be set carefully because it is hard
to change in DB structure.

e The Maximum Fingerprint Number - Sets the nhumber of fingers
that can be registered for each individual.

-

'When you use AY-B91xO0BT, it is only applied. In

ABio9000 program, you can register 10 fingerprints per
users. For these models, it can apply 1 or 2 fingerprints
depending on the registered fingerprint order.

\

In case of AY-B9250BT and AY-B9350, you can register 10
fingerprints for maximum regardless of the setting value.
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e User ID length (4~20) — Set the ID length from 4 to 20 digits.
(AY-B91x0BT: 4~15)

If AY-B91xO0BT is selected, ID length is limited with 4 to 15 digits.
After changing the maximum fingerprint registration number or
user ID length, click [NEXT] to see the warning window as
below.

AccessManager:

\? / Do not restore small value after saving. Will you continue?

[ es ] [ Mo

m RF Card Type

If RF cards are used to authenticate users, the type of RF card
must be the same as that in the terminal’s configuration value.

If the RF card type is changed while the program is in use, the
RF values of all users must be changed.

MIFARE — 34Bit, EM — 26Bit

m RF Input type
Two kind of RF input type are supported in Bio9000.
One blank for the specified card numbers is provided in

[Unified] mode when user registration. In addition, two blanks
are provided in [Separated] mode.
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Two blanks contain facility code and card nhumber of the card.

If facility code is used in the card type, [Separated] mode must
be applied.

The facility code is that defined number for the site. For more
information about facility code, please refer to a card
manufacturer.

m RF Storage Option

If the RF information is already registered when modifying the
user information, selecting the option will not delete the
information even if you don't use RF authentication type.

If you deselect the option, the RF information will be
automatically deleted.

Fingerprint I Enrall Fingerprint

Password

Re-enter Password

RF Card Number

[[] Using Personal Setting

Fingerprint Enroll Fingerprint

Password

Re-enter Password

RF Card Number

[ Using Personal Setting

B SOCUITY. LV - eeeeeeeeeeeeeeeeeeeeeeeeeeennt

A security level is selected for fingerprint authentication.
Minimum security is 1 and maximum security is 9.

e 1:1 Security Level (1 to 9) — This value is used when
authenticate by fingerprint with User ID. (Default: 5)

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 55

e 1:N Security Level (1 to 9) — This value is used when
authenticate by fingerprint without User ID. (Default: 8)
(not yet supported)

AT he security level must be high if greater security is

“required. However, at high security levels, actual
user fingerprints may be rejected more often. At

low security levels, the fingerprints of people
who are not the user may be accepted more

m Encryption Method

Set whether to encrypt the data transmitted to and from the
terminal over the network.

o Communication Encryption — Refers to the encryption method
for communication packets. DES encryption is supported.

If the communication encryption is not used, the transmitted
data will not be encrypted.

m Checking for Similar Fingerprints when Registering

When a fingerprint is being registered, the server will check
whether the same or a similar fingerprint already exists in the
database, and block registration if such a fingerprint exists.

« Similar Fingerprint Probability (10 ~ 100%) — The value is set
in percent. The top x% of all registered fingerprints that are
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most similar to the new fingerprint will be checked. (not yet
supported)

For example, if 100 users are registered, the similar fingerprint
probability is set at 10%, and a fingerprint is registered, the top
10% of all registered fingerprints that are most similar to the
new fingerprint will be checked.

The 100 registered users will have already been sorted based on
fingerprint similarity.

After configuration is completed, click [Next] to proceed.

m System Log Save Option

For the system logs only, you can choose to save the logs you
want using System Log Save Option.

The system logs are diverse and occur frequently. So they need
to be saved in consideration of the system capacity. Choose only
the logs you need.
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System Log Saving Option X!
Check choicely if you want to save system log.
I System-Log
[¥] Option Setting (V] Remote Manager
[¥] User Management (V] Terminal Management
(V] Group Management  [V] Privilege Management
Door Control
I Temminal Log
[¥] Option Setting [¥] User Management
[V] Network (V] Door
(V] warning & Error [ Log duplication deny
[ (1] ] [ Cancel

(4) Administrator Registration
In this screen, the administrator of Bio9000 can be registered.

m Basic Information

The length of the user ID must be equal to the length set in the
server.

The user ID and user name must be entered.

(Up to 29 characters can be entered for user name, organization,
and resident registration number/employee number, and up to
49 digits can be used for the description)
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m Configuring Authentication Method

Different combinations of fingerprints, passwords, and RF cards
can be used for terminal access authentication.

After inputting all information, click [OK] to complete
administrator registration and run Remote Manager.

-

If you want to enroll the fingerprint from the
AB|09000 program, the DR-B9000 should be needed.

.How to enroll the fingerprint and to insert the
~personal information describes on the Chapter 4.

It case of an administrator, unlike the regular
Ausers as he must log in remotely with a client
program, if there is no fingerprint recognition
device, as he must log in with a password to the
program, therefore the combination

authentication is intended to be made with "OR”

of fingerprint and password.

m Card Issuing
Click the [Issue] button after input all information to issue the
card.
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Menu Layout and Icons

m Menu Layout

This section describes the overall menu configuration of the
Remote Manager program.

fom |

Fie Vew Window  Teminaiseting 1ol He 1

N Terminal

e i 0

(6 Envoll Teminal [::] a ED Teminal Search o+ 0

e S S S 7S Y

© AulLog Management

© SystemLog Management

© Fiivlege Management

© Opton Setting
© Tinezone Setting

(1) Menu Bar
The following are Remote Manager’s basic menus.

File — Conducts functions such as user, terminal, group, and
Privilege registration, as well as reconnection and disconnection.
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View — Selects the screen layout. The Information Management
window can be displayed or hidden, and if the Homepage option
is selected, the Rosslare’s website will appear on the List window.

Window — allows the following to be selected from the
Information Management window: User Management, Group
Management, Terminal Management, Authentication Log
Management, Schedule Setup/Management/Search, Result
Search/Process, Privilege Management, Timezone settings,
System Log Management, and Option Settings.

Terminal Settings — offers the following functions: configure
options for terminals connected to the server, configure
fingerprint reader, set time, download log/Wallpaper, download
firmware, door control, synchronize, general synchronize.

Tools — Monitors terminal, authentication logs, Position
Management, notice management, user message management,
user export, user import, log import and can print data in Excel
format, APB Setting, Extend T&A Management.

Help — Displays the version information of the program.

@ Information Management Window

This window is where management menus are selected. If an
item is selected, the related data will be displayed on the list
window to the right.
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® List Window

This window displays the data list and related information of
items selected from the Information Management and Option
Setting window. By double-clicking the data, detailed information
can be viewed. The administrator can select multiple items using
the <Shift> or <Ctrl> keys.

m Icons
This section explains the icons that are displayed on the list
window when items are selected from the Information

Management window.

o User Management

LzEr Description
Status P
! General user.
Sa Administrator.
[
D Power user.
R | Guest.
(o) .
[ Expired user.
& | Temporary registration
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e Group Management

Group
Status

Description

o

Group.

« Terminal Management

AY-B91x0BT | AY-B9350

. * | Normal status.
User number error,

Es synchronization list error, or time
zZone version error.

Es Connected but unregistered.

Ex Not connected.

Eq "5 Other errors.

o Authentication Log Management

Log s
Status Description

[ Authentication success logs.

Authentication failure logs.
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¢ System Log Management

Log .
Status Description
o, Logs related to user registration, deletion, and
= changes.
@ Logs related to Terminal reconfiguration.
) Logs related to program execution and
’ reconfiguration.
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Managing Users

Users can be registered, deleted, or changed.

RosslareBio9000
e Vew Window TemialSeting Tool Heb

ROSSINR=
B8 9000
[

n Management
- Tope Keprd Persons: 1
Every User o] Seach | @  EnolUser @B ModiyUser  E) AuhenticalionList B3 Delle User
L
© Access Management Base78 sam Master W 0

© AuthLog Management

© SystemLog Management

© Pivlege Management

© Schedue Setup

© Opton Setting
© Tinezone Seting

(1) User Registration

Click [User Management] on the Information Management
window.

Click [Enroll User] at the top of the List window, or right-click
the List window and click [Enroll User].

Or, select [File] > [Enroll User] on the menu bar.
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m Basic Information
e User ID — Enter a unique user ID.

ID length can be changed according to server and terminal
settings. Enter an ID with the length determined in the server
settings and administrator registration.

e User Name — Enter the user name to be displayed on the
server and terminal. (Up to 49 characters)
The user ID and user name must be entered.

« Group — The user can be assigned a group registered in the
Group Management. The user will belong to the selected group.

« Access Group — Set the access group. When registering, you
can register only 1 access group. When modifying, you can set
many access groups via [Setting] button.

« Position — A user’s position can be assigned in the Position
Management.

o Privilege — The user’s Privilege can be set.

The Privilege levels are Administrator, General User, and Guest,
as well as the Privilege level registered in Privilege
Management (power user).

An administrator can use both Bio9000 and Access Monitor.
There is no difference between a general user and a guest, but
temporary users are given guest status.
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Power users could obtain various authorities by administrator
on the [Privilege Management] menu.

By changing the administrator/associate administrator log in to
the Bio9000 program to a regular user/visitor, they are logged
out of the program automatically.

« Temporary Registration: When the user cannot come to
enrollment center, enroll basic user information temporary and
when the user try to authenticate at first on the remote area, if
success, user Privilege is upgrading to normal user level.

e Time Zone Code — The user’s time zone code can be set.
If a certain time zone code is given to a user, access will be
restricted based on the time zone.

o Department — Enter the user’s organization. (up to 49
characters)

e Personal Number — Enter the user’s resident registration
number or employee number. (up to 49 digits)

« Country code / Phone number — Enter the phone number of
user. This information is used when issuing mobile cards.

For the user who already issued the mobile cards, it is not
available to modify.

« Description — Additional user information can be entered. (up
to 49 characters)

« Registration Date — Date the user account was registered.
This data can be changed if server has created a reserved user.
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For reserved users, the account will be activated on the
specified date. If a terminal to download to is added after
registering a reserved user, the user will be automatically
downloaded to the terminal when the account is activated.

« Expiration Date — Can set the date the user account expires.

If an expiration date is set, authentication cannot be done with
that account after the expiration date. Setting an expiration
date is useful for guests.

d

xp$=0r the user information with the specified \

expiration date, the deletion of user will be preceded
from the Bio9000 program to the terminal
automatically. The conditions to precede the automatic
deletion are as follows:

- At every midnight (between 00:00~00:10), it
transmits the request of deletion of user from the
server to the terminal in batch.

- At the time of the start (or restart) of Bio9000
service, the request of deletion of the user is
transmitted from the server to the terminal in batch.
- At the time of registration/modification of the user

information, it transmits from the server to the
wminal. //

e Email — Input the user’s email.
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« Import Image — Each user can insert pictures or various
images and print out when authentication succeeded at the
terminal device.

Image format supports bmp, jpg, gif, png and tiff types which
are adjusted to the print-out size at the terminal regardless of
picture size.

,Some built-in webcams may not work properly.

Please use an external webcam whenever possible.

« Image Capture — Users are able to register images which are
captured by PC camera if PC camera is available in your PC.

3]

Capture Dialog

Logitech QuickCam E3500 v

| Capture I [ Apply ] [ Cancel ]

Image Capture dialog will be pop-up on the screen when
[Image Capture] is clicked. Then, users can select a camera
device which is installed in your PC through the Combo-Box
and real-time images will be appeared on the left window.
Secondly, captured image will be appeared on the right window
when [Capture] button clicked and click [Apply] to register
captured image.
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m Authentication Method Setting — The method for
authenticating users can be set.

The authentication method can be a combination of fingerprint,
password, and RF card. For details about the authentication
process, see the terminal manual.

When selecting more than one authentication method, either
[AND] or [OR] must be selected.

-
AND - Authentication will work only if all authentication

requirements are satisfied.

OR — Authentication will work if one of the authentication
requirements is satisfied.

e Fingerprint — Compares user’s fingerprint with a registered
fingerprint for authentication.

« Password — Authentication is done using a registered
password. The password can be from four to eight digits.

 Password Confirmation — Enter the password again to confirm.

o RF Card Number — Authentication is done using an RF card.
Available only at RF card module added terminal.

The RF card number consists of a facility code and the RF card
number. The facility code and RF card number must be entered.
In case of the single code (No facility code), [Unified] must be
selected on the [RF Input Type] option.
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The facility code is that defined number for the site. For more
information about facility code, please refer to a card
manufacturer.

If you check “"HEX" item, you can type hexa-decimal number in.

e You can read a value of RF from card reader device using
[Searching] button (the left of RF number edit window)

e Face — It is a way of face authentication. A face template can
be used in the FACE terminal, added, and  modified in the only
Terminal.

o Auth-Type Setting (SOC only) — Authentication type of SOC
devices is different with others.

RF authentication would be selected automatically when
fingerprint authentication is selected.
(Authentication sequence — RF = FP)

If password authentication is selected, RF card is not required.
(Authentication sequence — PW only)

If FP and PW are selected to way of authentication, RF button
will be checked automatically.
(Authentication sequence — RF > FP > PW)

ﬂWhen one’s authentication type is changed under
—extended authentication type is set, extended

authentication setup is released automatically.
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m How to register the remote fingerprint

Remote fingerprint registration is the feature that the user
doesn't use the hamster for fingerprint recognition but register
the fingerprint in the terminal which is located remotely.

This feature is used to register the fingerprint remotely when

the installed terminal and administrator are far away.

Below is how to use.
From the screen to register and modify the user, click [Remote

Enroll] button next to [Enroll Fingerprint] button.

| SetAuth-Type

Mobil

le Card FP Opw RF

Fingerprint Enroll Fingerprint

Password

Re-enter Password

Number [JHEX| 2614647322 Search

RF Card

Face 0OR ~

Remote enroll

Check the fingerprint to register.

Remote enroll

[Jwo

s s Oz

e

Please check the finger you want to enroll fingerprints.

02 B2 Os
s

01
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You can see the terminals which are available for remote
registration as below.

Remote enroll X |

I Available Terminal List

Temminal ID | Terminal Name | Firmware Ve... | Result

[m ! test 2.003 - 0055

FHequest I Apply Close

Fingerprints can be registered through one terminal at a time. If
you select one terminal and press [Request] button, the
fingerprint sensor of the remote terminal operates. At this time,
enter the fingerprint to register twice.
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If the fingerprint input time (10 seconds) is exceeded or the
fingerprint capture fails, it processes failure and the fingerprint
cannot be used. The communication between the administrator
and the fingerprint registration user is important.

After you enter 2 fingerprint templates and succeed, [Apply]
button is activated.

Remote enroll m

I Available Terminal List

[ Teminal ID_| Terminal Name. | Firmware Ve... | Result

4 test 2.003 - 0055

Request Apply Close

If you select [Apply] button, the fingerprint will be used. If you
select [Request] button again, the previous fingerprint will be
deleted and the fingerprint can be input again.
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You can only register one finger at a time. If you want to
continue to register, check another finger and proceed with the
registration process again

Remote enroll X
[ N

Please check the finger you want to enroll fingerprints.

Os 5° o 02 5 O

e .

When you select [OK] button, the fingerprint is saved in the
user information. When you select [Close] button, the
fingerprint is not saved but deleted.
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m How to register the remote RF

The remote RF registration feature is to receive RF directly
from the terminal without using the RF-recognized hamster.

The feature is used to register RF remotely if the installed

terminal and manager are far away.

Below is how to use.

Check the RF authentication type in the screen of user
registration and modification and then select [...] button.

Re-enter Password

[ R RESN e

I Setauth-Type
Mobile Card FP Opw RF Face AND
Fingerprint Enroll Fingerprint Remote enroll
Password

RF Card Number U I

When you select the button, you can see the available terminals

for remote registration.
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Remote enroll %}

I Available Terminal List

[Teminal ID_| Teminal Name | Firmware Ve... | Result ]
4 test 2.003 - 0055

Request Apply Close

RF can be registered through one terminal at a time. Select a
terminal and select [Request] button to send an input signal
from the remote terminal.

If the RF input time (10 seconds) is exceeded or the RF capture
fails, it processes failure and the FP cannot be used. The
communication between the administrator and the RF
registration user is important.

When RF card input succeeds, [Apply] button is activated.
If you select [Apply] button, it is entered in the user

information. If you select [Request] button again, the previous
RF will be deleted and the RF can be input again.

I Setiuth-Type -
Mobile Card FP Opw RF Face AND v
Fingerprint Enroll Fingerprint Remote enroll
Password

Re-enter Password

RF Card Number O Hex|l |/ search

M- L .
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(2) User Editing

Basic user information and authentication methods can be
checked and edited.

Select [User Management] in the Information Management
window.

Select a user from the List window and click [Modify User], or
double-click the user.

Alternatively, right-click a user, and select [Properties].
(3) Changing Authentication List

Select [User Management] in the Information Management
window.

Select a user from the List window to change the authentication
list and click [Authentication List] near the top of the List
window. Alternatively, right-click the user and click [Auth-List
Modify].

It can be decided whether the user will perform server or
terminal authentication.
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User authenticated list information (Terminal ID : 101)

} UserList Using § User List Using
Server Authentication Persons 1 Terminal Authentication Persons, PP 172

UserlD & UserName Group ID UserlD & UserName GiouplD  Master FP.Co.. |
821234 admin [} &8a0000 0000 0 ] 2

( ]

e Terminal List (Authenticate by Server) — If a terminal is added
to the list of server authentication terminals, the server will
conduct user authentication at the terminal.

e Terminal List (Authenticate by Terminal) — If a terminal is
added to the list of independent authentication terminals, user
authentication will be done at the terminal.

To delete a terminal, select the terminal from the Change
Authentication List window and click [Delete].

To register a user as the master of a terminal, check the
terminal’s Master field on the Terminal List (Authenticate by
Terminal) and click [Master]. Remove the checkmark from the
Master field and click [Master] to cancel the user’s master
Privilege.
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To add a terminal, click [Add] on the Authentication List Change

window. The following window will appear allowing terminals to
be added.

Select a terminal to add and click [Apply] to add the terminal.

Authenticate in Terminal
1 Available Teminal Listfor Addiion
TeminallD  TeminalName St Mast
(@000 Right Nomal ]
( )
—
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(4) Deleting Users

Select [User Management] from the Information Management
window.

Select a user to delete from the List window and click [Delete
User] or press the <Delete> key on the keyboard.

Alternatively, right-click a user and select [Delete].

Multiple users can be deleted by using the <Shift> or <Ctrl>
keys.

(5) User Search

If many users exist in the database, search conditions can be
used to make searching easier.

Select [User Management] from the Information Management
window.

Select a category in the search bar near the top of the List
window and enter a keyword. The search results will appear on
the List window.

Categories: User ID, User Name, Privilege, Auth Type, Group ID,
Position / Department.
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(7) Setting time-zone code for each user

A user’s time-zone can be set as a different value for each
terminal.

Select [Setting time-zone code for each user] on the menu
after clicking right mouse button.

Setting up terminal time-zone info. for each user (user ID : D00DOD0) @
Terminal list enrolled
Set Timezone code
Terminal ID Terminal Name  Status Timezone C... Status
(B Terminal 01 Not Connected 0 0:Default
[ Terminal 02 Not Connected 0 1:Timezone 01
(<] Termfnal 03 Mot Connected 0 > Timezons 02
@4 Terminal 04 Mot Connected 0
[ Terminal 05 Mot Connected 0 3iTimezone 03
4:Timezone 04
S:Timezone 05
< >

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 83

It shows terminal list user(s) be enrolled, Set time-zone is
activated as a button type in the [Set Timezone code].
You can set it up after choosing terminal(s) and clicking time-
zone button to be set.

[0: Default]: according to time-zone set in the user basic
information.

Time-zone value is set into the real terminal when you are
clicking [Apply] after choosing terminal(s).

JIn case of dis-connection or different option values with
“the server, it is not applied to the terminal.

After terminal status is normal, synchronization error
will occur. Please, synchronize terminal(s).
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Managing Groups

Users can be managed by group.

RosslareBio9000 (=1 E3)
Fie View Window TerminalSettng Tool Hebp

ROSSINR=

gegcoo

B Envol Growp odiy Group B3 Delete Group User List

L] Growp 1D [ Group Name
Descripton [
@ AuhLog M I Wah subtems [N
SytemLog Managen beieUser |
© Piiviege Management UserID [ UsecNeme | Department
Basere sam
TNA Management

Schedule Selup

© Schedule Management
© Schedule Seaich
Result Search

© Result Process

Meal-Service Management
sl ing

P

All groups will be listed in Group Management Menu.

When user authentication is succeeded, the group ID will be
displayed on the terminal screen.
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(1) Registering Groups

Select [Group Management] in the Information Management
window.

After selecting (") the upper group to register as subgroup,
select [Enroll Group] button in the upper list.

Or select [File] = [Enroll Group] on the menu bar.

ig Please enroll a group information.

I Basic Information

Group ID (1 ~ B65535) l ‘

Group Name ’ ‘

Description { ‘

[ 0K ][ Cancel
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Group ID (1 ~ 65535) — Enter the group ID.

Group Name — Enter the group name.

Description — Enter additional group information.

Select [OK] button after enter items. New group will be
created under the selected group.

(2) Editing Groups

Select [Manage Group] from the Information Management
window.

It shows a specified group information in the left window when
you select a group what you want to modify.

Modify contents of an item what you want to modify

Entered data are changed when you click [Modify Group]
button. (Group ID can't be changed.)

(3) User add

Select [Group Management] in the left frame [Information
Management].

Click [User List] button after you select a group.

Available user list to add into the specified group is displayed.
Selected users are added into the specified group when you click
[Add] button after you check a “add” items what you want to

add in.
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Available User List to Addition 3]

ﬁ User list in the group.

I User List (1000]

UserID &

S8a5555
Sa5556
Sa5557
Sa5553
Sas559
Sas560
Sa5561
Sas562
825563

35564

User Name
5555
5556
5557
5558
5559
5560
5561
5562
5563
5564
5565
5566
5567
5568
5569
5570
5571
5572

ER72

[setect an][ Check ][ Uncheck |

Department Add &

. J000000000000000000

[ add [ Ciese |

(4) User delete

Select [Group Management] in the Information Management

window.

User list of a specified group is shown when you select a group.

Users are removed from the list and group information of those
is changed into unspecified group when you click [User Delete]
after you select users that you want to delete.
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® Group Delete
Select [Group management] in the Information Management.

Group information is removed from the list when you click
[Group Delete] button or enter “delete” key on the keyboard.

Or select groups what you want to delete. And then select
[Delete] menu after click a right mouse button

When you delete group information, all information under the
group is also removed. User information of a specified group is
changed to “unspecified group”
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(® Group Time zone Setting

Select [Manage Group] from the Information Management
window.

Select a group to change and right clicking firstly. Then, click
[Time zone Setting].

Timezone Setting @

I UserList I Timezone Information I Holiday List
UserID & User Name Timezo... Checl .
Timezone Code : v
820000000 0000000 0 (7]
&20000001 0000001 0 v Timezone Name : TEST2
S20000002 0000002 i} (]
8@0000004 0000004 i} (v) Holiday List Code : i}
S20000005 0000005 i} (V) -
Sao000005 0000008 0 v Holiday List Name :
&20000007 0000007 0 (v
&a0000012 0000012 0 (V]
&20000013 0000013 0 ™ 0 36 3 12 15 18 21 24
820000014 0000014 i (] Holiday
Sa0000015 0000015 0 (v] Mon
S20000016 0000016 0 (V) "
820000017 0000017 0 (v) Tue.
Sa0000018 0000018 0 v Wed,
820000013 0000019 0 (V] Thu,
&20000020 0000020 0 (v g
.
820000021 0000021 0 (v
Saooo0022 0000022 0 (v Sat.
820000023 0000023 0 (v Sun
20000024 0000024 0 (v)
&DDDDDZS 0000025 0 v ¥ ‘Work Completed. (Error Counts : 0)
< > (NN RNANANARNARNANARNARARA AN RN AN ANARNARRAN [}

User List — Users which are contained in selected group could be
checked easily by check-box to configure Time zone.

A many number of users could be selected easily by “All”,
“Check” and “Uncheck” buttons. Basically, all users are selected.

Time zone Information — Selected Time zone’s information will
be displayed by clicking Time zone Code in Time zone Code
menu. After select a Timer zone Code, [Apply] button should be
clicked to apply Time zone to selected users.
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Managing Position

You can manage various positions.

Select [Tool]-[Position Management] in the main menu.

Position Manage @

Position Name

Position0
Position1
Position2
Position3
Position4
PositionS

New position is created when you click [Add] button.
Position Name — Create the position name which you want (It
can be created up to 199 positions and give its name with 29
Characters maximally).

It can be modified by selecting again after selecting the added
rank (it is not a double-click).

A specified position is deleted when you click “Delete” button
and also group information is changed to unspecified group in
the relevant user information.
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Managing Access

Management of access group for each terminal or user.
One of access group can have many users as member, and it

can be designated to access many terminals. (N:N)

Additionally, user or terminal can be included in many access

groups.

RosslareBio9000
[Ee ] wiew Window  Termina seting

ROSSINR=
B/& 9000

lanagement

et
© Piiviege Management

Tool Help

Access Group

‘Access Group User

Access Group

D

Name

D

Name.

© Schedue Management

Group

v

Terminal

Result Search
© Result Process

Meal-Service Management
vice Seting

Option Selting

© Timezone Setting

oAl

D

Name

(=1 E3

(1) Registering access group

To register a new access group, input “access group hame”
and click the button to add it. The button ¥ must be clicked to
apply it after designating “access group user” and “access
group terminal”
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(2) Adding/deleting access group user/terminal
Use this button © ¥ to add or delete “access group user”
or “access group terminal”. This button ¥ must be clicked to
apply it after registering.

(3) Deleting access group

To delete “access group”, select access group desired to be
deleted and click this button. %
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Managing Terminals

Terminals can be registered, deleted, or edited.

RosslareBio9000 [_[o]x]
Fie Vew Window TeminalSeting Tool Heb
Informalion Management
5 Group Mansgement 8 Encl Teminal @ Termind nomsion siontist 3 Delte Terrinal [} Teminal Seaich o :
I
Aoosss Management
n

SystemLog Management

© Piiviege Mansgement

TNA Management
e Set

.

Option Setting

Timezone Seting

The [Terminal Management] title will be changed if abnormal
terminal devices are listed.
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(1) Registering Terminals

Select [Terminal Management] from the Information
Management window.

Select [Register Terminal] near the top of the list window.
Or, right clicking on the List window then click [Register

Terminal].

Or, select [File] > [Enroll Terminal].

Register Terminal

!

Please register terminal information

I Basic Information

TeminallD (1~2000) ||
Terminal Name

Description

[ 0K ] [ Cancel ]

Terminal ID (1 ~ 2000) — Enter the terminal ID which will be
used for identification by the server.
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For a connection to be made, the terminal ID entered in the
terminal registration window and the terminal ID set in the
terminal must be identical.

Terminal Name — Enter a unique terminal name.

Description — Enter additional information.

If the terminal is registered by selecting a terminal
‘egistered already, some setting information of the

terminal registered already is registered in same.

(2) Terminal Information

Basic terminal information, terminal configuration, and
fingerprint scanner settings can be checked or edited.

Select [Terminal Management] from the Information
Management window.

Select a terminal to check or edit in the List window, and select
[Terminal Information]. Or, double-click the terminal.

Or, right-click the terminal and click [Properties].
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@AY-B9350, AY-B9250BT Terminal Information

m Basic Information — The terminal’s basic information can be
checked and edited.

Terminal Properties (Node ID : 8)

-
o

Basic Information

SECURITY PRODUCTS

Q,] Network I Basic Information
&? System
Terminal ID g
Display
i T9
[T Timezone Checking Terminal Name
Description
Registered Date 20150519
Status Normal
IP Address 192.168.0.188
Firmware Version 1.03
I Option Setting
TNA Management [NDI Use v]
Meal-Service [Not Use v]
UTC Timezone:
[(UTC+09:00) Seoul =
OK ] [ Cancel Apply
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Management of T&A — You can choose whether you use a
terminal as a T&A mode or not.

Management of Meal Service — You can choose whether you
use a terminal as a Meal Service mode or not.

X Please, refer to T&A manual attached separately with regard
to contents of T&A and Meal Service.

If current time is different a server with a terminal, current
time on a terminal could be configured by UTC Time zone
menu.
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m Network — Set server IP, Terminal IP, etc.

-
Terminal Properties (Node ID : 1)

7] Basic Information
al I Server Information

+3 Network
£S5 System IP Address  192.168.0.60
| Display Port 7332

@ Timezone Checking

I Teminal Information

) DHCP @ Static IP

IP Address 192 0168 . 0 . 142

Subnet Mask 255 0255 285 . 0
Gateway 192 168 . 0 . 1

DNS o. 0.0 .0

e Server information

IP address — Set IP address of the server. You can give the
server IP with the type of IPv4 or server computer’s name.

(But the name of computer should be less than 15 characters.)

Communication port — Set communication port of the server.

Default port value of ACM server is 7332. If this value is
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changed, server program must be also changed with the same
value. Hence, be cautious of changing it.

« Terminal information

DHCP — Set network setting of terminal to be automatically
allotted. If this option is selected, network information input
item of terminal will be inactivated and input is impossible.
Static IP — Set network information of terminal to static IP.

IP address — Set IP address of terminal.

Subnet mask — Set subnet mask of terminal.

Gateway — Set gateway address of terminal.

DNS — Designate up to 2 DNS of terminal.
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m System — System related setting of terminal is possible.

-
Terminal Properties (Node ID : 1)

-

\

£ Network
~ Order |Server/Teminal v
IE System
Display I Fingerprint
[ Timezone Checking Set 1:N Security Level E]
Set 1:1 Security Level
I Face
Face matching level
Face recognition
Camera angle
Enrollment Sensitivity
I Date / Time

@Basiclnfnrmalion o
I Authentication

Display format | yyyy-Mb-dd v

H

o Verification method.

Sequence — Decide verification priority between terminal and
network server. Perform verification according to the setting
sequence.
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o Fingerprint

1:N security level setting (3~9) - Verification level used for 1:N
fingerprint verification. In case of 1:N verification, verification level
of each user will not be set. Hence, it will be always set based on
verification level of terminal.

1:1 security level setting (1~9) - Verification level used for 1:1
fingerprint verification. However, use 1:1 verification level of the
relevant user for users for whom 1:1 verification level is not to set
to ‘0’ (use of verification level of terminal).

Forgery fingerprint security level setting - Set LFD level to
prevent input of forgery fingerprint. Higher LFD level is set,
stronger function to prevent input of forgery fingerprint made of
rubber, paper, paper or silicon will be. However, too dry
fingerprint can be hard to input registered fingerprint.

e Face

Face verification level — Level used for face verification. Set it to
step of 1 ~ 4 according to matching rate to registered face.
Verification matching rate must be higher than setting verification
level to make verification to be passed.

Higher verification level means higher security. However, since
it requires relatively high matching rate, possibility of failure for

user verification will increase.
Face verification mode — Designate face verification method.
Set it according to usage environment.

Camera angle — Set camera angle.

Registration sensitivity — Set registration sensitivity of face
verification.
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o Date / time
Display method — Method to display current time of terminal.
- yyyy-mm-dd: Display in the order of year, moth, date
- dd-mmm-yyyy: Display in the order of date, month, year

m System — Set the terminal system, (Only for eNCARD-i)

Terminal Properties (Node ID : 333) X
=
(@] Basic Information o
~ I Authentication
£ Network
Order | Temminal/Server v
Terminal I' Face
() Display Use [JRF
Timezone Checking [ Password
Detection Level | Level1 v
I Date/ Time
Display format | Use v
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« Authentication type

You can set the user authentication type.
- Server / Terminal

- Terminal / Server

- Server Only

- Terminal Only

 Face Recognition

It only recognizes the user’s face, which means that it doesn’t
recognize the specific user’s face. For details, please refer the
guide.

Detection level

If one of the check boxes is selected, this defines the face
detection detail.

1) Level 1 — Default Face, Fast
2) Level 2 — Detailed face, Can take a little time

e Date / Time

It can display or hide the date and time which are displayed in
terminal.

m Terminal — It can check and modify the detailed option of
terminal.
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Terminal Properties (Node ID : 333) X
[ﬁj Basic Information I Sound
§ ::::::k Voice I 10 Beep I 0
Terminal I Cardreader | Standard v
@ Display I Input
Timezone Checking M0 | Door Monitor NC v~ M1 NotUse v
M2 | Not Use ~ 10 NotUse v
Warn door open(sec) D [ Tamper alarm
I Lock
Lock 1 Option | Strike/Auto/0K v duration[ms)
Lock 2 Option | Fail ~ | duration[ms)
[] Lock teminal
I' External Device
Wiegand site code D
wiegand Output | NotUse v
Wiegand Input 34bit v
Cancel Apply
« Sound

Voice (0~15) — Set the voice volume.
Buzzer (0~3) — Set the buzzer volume.
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o Card reader — It can set Standard and HID IClass, which can
recognize the setting type of card.

¢ Input setting

MO — Set when connecting the external interface into DMO.
(Set [NO] or [NC] when using the motor lock.)
- No Use: Connect nothing.
- NO or NC: In case of connecting the monitoring pin of door
open status -> Set NO/NC depending on the pin status when
detecting.

M1/M2 — Set when connecting the external interface into
SDM1/DM2.
(When using the motor lock, set [NO] or [NC].)
- No Use: Connect nothing.
- NO or NC: In case of connecting the monitoring pin of door
open status -> Set NO/NC depending on the pin status when
detecting.

IO — Set when connecting the external interface into Exit pin.

- No Use: When connecting nothing.

- Inside Open NO or Inside Open NC: When connecting Exit
button. -> In case of connecting the monitoring pin of door open
status -> Set NO/NC depending on the pin status when
detecting.

Warning time for door open (Second) — It is a function that the
terminal checks the open time and sounds a warning sound if it
is open for more than the set time (minimum 5 seconds ~
maximum 60 seconds).
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If it is set to [0], it will not beep anymore, and if it is set to
[01 ~ 04], it should warn for at least 5 seconds and the alarm
will sound.

The door must be closed within the set time, but if the door is
not closed due to an unexpected situation, a beep will sound
and the door will be closed to allow the door to be closed
normally.

To use this function, the lock must be monitored whether it is
currently opened or closed, and the monitoring pin of the lock
must be connected to MO0. Also, the preceding MO must be set
to [NO] or [NC].

Terminal disconnection notification - A beep sounds when the
terminal is disassembled.

e Lock Setting

Lock 1 Option

- No Use: No Use

- Strike/Auto/Authentication success alarm: When connecting
the warning light to display a strike type, an automatic door
and authentication success / failure.

- Motorlock 1: When connecting the motor lock

Lock 2 Option

- No Use: No Use

- Authentication failure notification: When connecting the
warning light into Lock to display the authentication failure

- Motorlock 2: When connecting the motor lock

Lock 1 time (ms unit)
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- - Specifies the time to give a signal when Lock1 is set to
'Strike / Auto / Authentication Success Notification'. Because
it is set in ms unit, if set to 3 seconds, it should be set to
3000. Strike type means the time until the door is locked
again after opening the door after authentication.

Lock 2 time (ms unit)

- When setting Lock 2 as ‘Authentication failure notification’, it
sets the time to give the signal. Since it is set as ms unit, if
you set 3 seconds, you should set 3000.

Terminal Lock setting - A function that allows the administrator
to set or unlock the terminal directly on the terminal, not on the
server program. The administrator unlocks it until no one is
locked out

m Display — Set background and language of terminal.
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—
Terminal Properties (Node ID : 1) lg
— V""
|
I @ Basic Information X
I Backround image
£ Network — =
ﬁs System -
|| &f Display
Timezone Checking
° ©
I Camera save option Success Fail
1 SetLomunge
I Sereen saver
I User display option
I Message display time 2000

« Background screen — Set background of main screen.

« Camera display setting — Select image to be displayed in
verification success message window.

- Not displayed.

- Registered user picture.
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o Camera save setting

If verification is passed — Capture camera image and save it as an
image log.

If verification is failed — Capture camera image and save it as an
image log
(You can select both cases when select all check-boxes)

« Language select — Voice message and message displayed in the
screen will be changed into the setting language.

% Supporting language
(English, Korean, Japanese and Portuguese)

e Screen saver — LCD screen will be automatically OFF if nothing
is input for the setting time. However, if it is set to ‘Not use’, LCD

will be always ON.

e User display setting — Set display detail when verification is

passed.
None Display verification result of [passed/failed]
User ID Display user ID
User name If not registered, display user ID
(In this case, add “ID:"” for distinction form
name)

Employee No If not registered, user ID display
(In this case, "ID:" for distinction from employee
No.)

e Message time setting — Set time to display verification result
window. Setting from 0 to 5000 is possible. Verification result
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window will be displayed as long as setting time and it will
disappear. Since it is ms unit, input 2000 to set it to 2 seconds.

m Time zone Checking — is set to the current terminal time zone
information can be found and changed.

Terminal Properties (Node ID : 1) lﬂ

(@] Basic Information
2] Network
@3 System

( Display I Timezone Information I Holiday List

Uiz 2 e Timezone Code Not Selected v

Timezone Name

I Timezone Version 8

Holiday List Code

Holiday List Name

0 3 3 3 12 15 18 21 24
Holiday |
Mon. [
Tue.
Wed.
Thu,
Fri.
Sat.
Sun,

e Time zone version — displays the version of the current time
zone

e Time zone Information

Time zone code — is set in the current terminal to display time
zone code value. On this screen, change the code so you can
change the settings for the terminal time zone.
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Time zone name — displays the name of the selected time zone
code.

Holidays list the code — the code is applied to the selected time
zone code to display the list of holidays.

Holidays list the name — the name of the code is applied to
display the list of selected holidays.

Holidays list — display the selected holiday list
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@AY-B91x0BT Terminal Information

m Basic Information — The terminal’s basic information can be

checked and edited.

Terminal Properties (Node ID : 4) E

Basic Information
§j Terminal Setting

I Basic Information
f#5 Timezone Checking

Terminal 1D
Fingerprint Setting
[ Others Setting Temminal Name
Description

Registered Date
Status
|P Address

Firmware Yersion

I Option Setting

test
2/24/2019 % I
Normal
192.168.10.25
2.003 - 0055

TNA Management Not Use 'I
UTC Timezone:
| (UTC+02:00) &mman |
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Management of T&A — You can choose whether you use a
terminal as a T&A mode or not.

Management of Meal Service — You can choose whether you
use a terminal as a Meal Service mode or not.

X Please, refer to T&A manual attached separately with regard
to contents of T&A and Meal Service.

If current time is different between server installed area and
terminal installed area, terminal’s current time could be
configured by UTC Time zone menu.

m Terminal Setting — The terminal’s detailed options can be
checked and edited.
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Terminal Properties (Node ID : 4)

(@] Basic Information

I Option Setting

Timezone Checking

V' Saving log [~ Timezone
Fingerprint Setting
Others Setting RF Card Use IUsing j
Time Out for comm.(Sec) |1 0 ::|'
Set Language | Engish =
Encrypt Type |oES |
Server Authenticate Type ITerminal/Server j

I Time of terminal (read only)

|3/1 4/2019 2:25:15 PM
I wiegand
Bit Length IZS bit LI
Mode IUser D 4|
Facilty Code{0"255) fo

|
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m Terminal Setting (AY-B91x0BT) — The terminal’s detailed
options can be checked and edited. Some setting will be
different depending on FW version.

Terminal Properties (Node ID - 256) li_z-J‘

(@] Basic Information

44 Teminal Setting I Option Setting

F#5 Timezone Checking

[¥] Beep [¥] Voice [¥] Timezone

Fingerprint Setting [7] Saving log [7] Function Key

() Logo/Fimuware Information

(52 Othes Seting FF Cad Type
Door Opening Time 5 =
OpenWarning 0
Time Out for comm.(Sec) 10 =
Set Language English =
Encpt Type
Server Autherticate Type

I Time of terminal (read anly)
20121226 2T 11:53.42

ok |[ cancel [ ppy

« Option Setting

Beep — Sounds are generated when screen is touched or keys
are pressed on the terminal.

Voice - Voice instructions are given when authenticating
fingerprint at the terminal.

Time zone — Sets whether time zone is used at the terminal. If
this option is selected, the terminal will have time zone-related
functions.
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Saving Log — Sets whether to save access data and system
change information. If the terminal is connected to the network,
event information is sent to the server in real time. If the
terminal not connected to a network, all data will be stored in
the terminal.

Function Key — If this option is selected, terminal function keys
can be used in application programs.

RF Card Type — If RF cards are used to authenticate users,
select the card type to use. The same type as the one in the
Option Setting must be selected.

RF cards are optional. They cannot be used in

%rminals without RF modules.

Door Opening Period — Sets how long the door will remain open
after the user is authenticated.

Door Warning Period — If the door remains open for longer
than the door opening period, an alarm will sound. If the alarm
sounds, check why the door does not close, and enable it to
close.

Time Out for comm (Sec) — If the server and a terminal are
communicating through a network and no response occurs
within the specified time, the network connection will be
considered nonexistent.

Set Language — Select the language to display on the terminal
screen.

Basically, it supports Korean and English (however, for the AY-
B91x0BT models without a LCD, it does not support).
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Encrypt Type — Set up encryption type for communication
packet. It supports DES / AES(128bit, 256bit). Some version of
terminal doesn't support AES encryption.

Server Authenticate Type — Set up used Server Authenticate.
« Set time of terminal (Read only)

Set time of terminal — The current time of the terminal is
displayed.

« Wiegand Setting

Whether to use — Set Wiegand Bit. You can select ‘No Use’,
Wiegand 26 bit, or Wiegand 34 bit.

Data type — You can select the card number or user ID.

Facility Code — This is the code value when the data type is the
Card number. When Wiegand Bit is 26 bit, you can set from 0 to
255, and when Wiegand Bit is 34 bit, you can set from 0 to
32767.

m Time zone Checking — is set to the current terminal time zone
information can be found and changed.
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Terminal Properties (Node ID : 4) X |

@ Basic Information

2] Teminal Setting I Timezone Version 0

Fingerprint Setting I Timezone Information — I Holiday List —
Wi Bl Timezone Code W

Timezone Name

Holiday List Code

Holiday List Name

Holiday
Mon.
Tue.
Wed.
Thu.
Fi [
Sat. [
Sun. [

Cancel Apply
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* Time zone version

Time zone version — displays the version of the current time
zone.

* Time zone Information

Time zone code — is set in the current terminal to display time
zone code value. On this screen, change the code so you can
change the settings for the terminal time zone.

Time zone name — displays the name of the selected time zone
code.

Holidays list the code — the code is applied to the selected time
zone code to display the list of holidays.

Holidays list the name — the name of the code is applied to
display the list of selected holidays.
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m Fingerprint Setting — The terminal’s fingerprint reader can be

reconfigured.
Terminal Properties (Node ID : 4) B
_—
(@] Basic Information
£] Teminal Setting I Fingerprint Sensor
@ Timezone Checking Briaht 40
rightness —J—
ﬁg Fingerprint Setting
X Contrast -—J— 20
@ Others Setting
Gain —J— 2
I Security Level Setting
Set 1:1 Security Level |5 ﬁ
Set 1:N Security Level |8 j’
LFD Level lNone ZI
I Others Setting
Capture Timeout (Sec) |5 ::ll
V' 1:N Timeout IZ ﬁ
Cancel Apply

« Fingerprint Sensor Options

Brightness — Sets the brightness of the fingerprint.
Contrast — Sets the contrast of the fingerprint.
Gain — Sets the intensity of the fingerprint.
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'These settings greatly affect sensor performance.
— It is recommended that the default settings be

-

. f the weather is very dry, the recognition rate
“may drop. In this case, adjust the brightness to
between 20 and 30. (20 is recommended)

. f the weather is too humid, adjust the

“brightness to between 50 and 80. (60 is
recommended)

e Security Level

A security level is selected for fingerprint authentication.
Minimum security is 1 and maximum security is 9.

e 1:1 Security Level (1 to 9) — This value is used when
authenticate by fingerprint with User ID. (Default: 5)

e 1:N Security Level (5 to 9) — This value is used when
authenticate by fingerprint without User ID. (Default: 8)

'The security level must be high if greater security
"1is required. However, at high security levels,

actual user fingerprints may be rejected more
often. At low security levels, the fingerprints of
people who are not the user may be accepted

e Others
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e Fingerprint Input Timeout — If the user does not scan a
fingerprint in the specified time, the scanner’s LED will turn off
and no scan will be made.

« Using 1:N Timeout — Fingerprint search time may be limited
for 1:N authentication. If this feature is used, the search will
only be done in the specified period.

« Capture Mode

Latent (Checking Residual Fingerprints) — This function
prevents errors caused by fingerprint residue from sweat or
moisture.

Intelli Capture — If the finger is too moist or dry, the
fingerprint’s brightness will be adjusted. The Intelli Capture
feature includes the latent function.

'Using the latent function or intelli capture will

—increase security but authentication time may
also increase. These functions are recommended
for high-security access control. For regular
access control (attendance management, etc), it
is recommended that these functions not be

used.
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m Set FP reader (AY-B91x0BT) — You can change the setting of
FP reader which is installed in terminal.

Terminal Properties (Node ID : 4) B
(@] Basic Information
£] Teminal Setting I Fingerprint Sensor
EE Timezone Checking Brightness | 40
ﬁg Fingerprint Setting
= ; Contrast -—J— 20
[1[ Others Setting
Gain —J— 2
I Security Level Setting
Set 1:1 Security Level |5 3—'
Set 1:N Security Level |8 j’
LFD Level INone ZI
I Others Setting
Capture Timeout (Sec) |5 ::ll
V' 1:N Timeout |2 ﬁ
LCancel Spply

« FP reader option

Brightness — Set the brightness of fingerprint image.
Contrast — Sets the sharpness (contrast) of the fingerprint image.
Gain — Sets the magnification of the scanned fingerprint image
from the fingerprint reader.
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4 N
ﬂThese settings are very sensitive for sensor
= performance and may significantly affect
fingerprint recognition performance.

We recommend using the default settings as
much as possible.

/
\

f If the operating environment such as winter is

ery dry and the recognition performance
deterlorates, adjust the brightness value to 20
~ 30 (recommended value: 20).

If the environment is very humid such as
ummer, and the recognition performance of
wet fingerprint is degraded, adjust only the
brightness value to 50 ~ 80 (recommended
value 60).

« Set the security grade
The larger the number is, the better the security is.

1:1 Security grade (1~9) — This is for the case when you enter
the user ID and fingerprint and then authenticate. (Default
value: 5)

1:N Security grade (3~9) — This is for the case when you don't
enter the user ID but enter only FP and then authenticate.
(Default value: 8)
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-

If high security is required, the security level
hould be set high, but in this case, the
rejection rate (the probability of failure to
authenticate even though you are yourself) may
increase depending on the status of the
fingerprint. Conversely, setting a lower security
rating may increase the acceptance rate of
others (the probability of granting
authentication to someone other than you).

The security level setting for fake fingerprint - You can set the
security level to detect forged fingerprint in 4 levels. The
security level is divided into High, Medium, Low and Disable.

o Etc.

Fingerprint input limit time - Wait for user's fingerprint input for
the set time. When the time elapses, the LED of the fingerprint
reader turns off and user cannot input fingerprint.

Use 1:N authentication timeout - You can set a time limit for
fingerprint scanning when 1: N authentication is used. When
the 1: N authentication timeout function is enabled, the
fingerprint will be retrieved only for the set time.

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 126

m Other Setting

Terminal Properties (Node ID : 4)

@ Basic Information

£ Terminal Setting I Door Settings
Timezone Checking ~Door 1
Fingerprint Setting Function Using

Result signal Success

Door Opening I5UUU =

| Kl | K

Open Warning 20 _:|
Open Setting
l Door Monitor NC l]

Cancel Apply
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You can set up two different doors and it supports only
AY-B91x0BT.

Function — Use a specified door or not, and it supports not a
fire alarm yet but a light alarm.

Result signal — Door open by a specified result

Door Opening — Select an opening time(seconds) after a user
authenticates and the door opens. (3~20)

Open warning — Warn via warning alarm when the door opens
more than time-set. (0~20)

Open setting — This is for LOCK setting. You can set door open
open status NC, and NO.

(3) User Authentication List

The list of users authenticated by the terminal is displayed.

Select [Terminal Management] from the Information
Management window.

Click [User Authentication List].
[User List Using Server Authentication] or [User List
Using Terminal Authentication] that will be authenticated

by the terminal can be added or deleted.

The [Master] button can give an authenticated user Master
Privilege or cancel the Privilege.
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mation (Terminal ID : 1999)

ey

— 7

User Listin Selected Teminal ///// 7 Z

ser Listin Selected Terminl Z // g

= 3

- 4

| UserList Using | UserListUsing
Server Authentication Persons 11 Terminal Authentication Persons/FP: 12/0

UserlD & UserName  GrowplD  Reserv.. UserlD & UserName  GrowplD  Master FP.Co.. Reser..

& 0000012 000002
& 0000013 0000013
£ 0000014 0000014
& 0000015 0000015
& 0000016 0000016
& 0000017 0000017
& 0000018 0000018
& 0000013 0000019
0000020 0000020
& 0000021 0000021
& 0000022 0000022

30000000 0000000
30000001 0000001
30000002 0000002
30000003 0000003
$30000004 0000004
0000005 0000005
0000006 000000
0000007 0000007
0000008 0000008
0000003 0000009
0000010 0000010
0000011 0000011

cooccocoococooo

cococoococooocoo
cococoococooocoo

000000000000

Add dd

Click [Apply]. In the user list, select a user and add him to the
terminal’s server authentication or terminal authentication user
list.

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide

129

Authenticate in Terminal @

I Available User List to Addition

UserID & User Name Group ID Master FP.Co.. Reserved &
& 0000023 0000023 0 ] o

2 0000024 DO0OD24 0 [ o

&£ 0000025 0000025 0 ] o

20000026 0000026 0 ] o

&2 0000027 0000027 0 ] o

&£ 0000028 0000028 0 ] o

20000023 0000029 0 [ o

&£ 0000030 0000030 0 ] o

&2 0000031 0000031 0 [ o

&£ 0000032 0000032 0 ] o

&£ 0000033 0000033 0 ] o

20000034 0000034 0 [ o

&£ 0000035 0000035 0 ] o

20000036 0000036 0 ] o

& 0000037 0000037 0 ] o

20000038 0000038 0 ] o

20000033 0000039 0 ] o

&£ 0000040 0000040 0 ] o

&2 0000041 0000041 0 ] o

&2 0000042 0000042 0 ] o

2 0000043 0000043 0 [ o

& 0000044 0000044 0 ) o v
< >

(

(5) Deleting Terminals — Selected terminals can be deleted.

Select [Terminal Management] from the Information

Management window.

Select a terminal to delete and click [Delete] or press the
<Delete> key on the keyboard.

Or right—click a terminal and click [Delete].
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The terminal that set Anti-Pass Back is not deleted. If the
setting is disabled, you can delete it.

® Terminal search — Terminal searched, and ID, IP address,
server IP address of unregistered terminal can be changed.

Search
Search Option
| [Broadeast 1p| 255 . 255 . 255 . 255 | Subnet Mask | 255 . 255 . 255 . 255
Terminal ID
Terminal D | ] Modify ID Auto ID Assign
Terminal Network Terminal Password
[JoHce Password |:| Apply
Start 1P | . . . |
Subnet Mask | I [Jchange Password
Gateway | . . . I
Modify P Auto TP Assign : Apply
D D Terminal IP MAC Address Server IP Hardware T... Firmware V... Registratio...
|
Request Connect Close
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In terminal find window, 5 functions are performed.
B Terminal search function

If “broadcast” is checked, press [search] button to search all
terminals within the network band same with the computer at
which Bio9000 is running. Searched terminal will be added in the
list. Perform additional works such as terminal ID change, terminal
IP change.

(When you cannot search terminals, we recommend you to
connect server and terminal with only 1 IP router.)

Search Option

V| Broadcast

IP 255 . 255 . 255 ., 255 SubnetMask 255 . 255 . 255 . 255

If “broadcast” is checked, press “search” button to search all
terminals within the network band same with the computer at
which Bio9000 is running. Searched terminal will be added in
the list. Perform additional works such as terminal ID change,
terminal IP change.
e R
iTerminal AY-B9350 needs the password when
sea‘srching the terminal. The initial password is
“43216789", which you can change. About the
explanation of terminal password, it is written
in “m Terminal Password".

—
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Check checkbox of terminal in the list to select ID. Click “ID
change” button to change ID of the selected terminal.

If the selected number of terminal is plural, click “auto ID allot”
button to allot ID in batch.

m Changing terminal IP address

Check checkbox of terminal in the list to select IP address. Click
“IP change” button to change IP address, Subnet Mask and
Gateway of the selected terminal.

If the selected number of terminal is plural, click “auto IP allot”
button to change IP address of terminal in batch.

m Server IP change

Click “Connection request” button after changing ID and IP
address of terminal to change IP address of ACM server
Terminal of which server IP address is changed can be added

in terminal management list by trying connection to ACM server.
The added terminal can be managed in Bio9000.

m Terminal Password

When you connect the terminal, you should enter the unique

password.
Terminal ID
Terminal ID | 122 Modify ID Auto ID Assign
Terminal Network Terminal Password

Startlp | 192 . 168 . 30 . 62
SubnetMask | 255 . 255 . 255 . 0 [ change Password
Gateway 192 . 168 . 30 . 1

Modify IP Auto IP Assign

D Terminal IP MAC Address Server IP Hardware T... Firmware V... Registratio...

-_ 192.168.30.62 | 00:02:65:15:b4:c1 | 192.168.30.52 2,000 - 0043 _
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Select (check) the desired terminal, enter the password, click
[Apply] button, and request connection. If the password is wrong,
it will not be connected.

If you want to change the password, select (check) [Change
Password] and enter the new password and then select
[Apply] button. If the password is wrong, it will not change
the password.

ASearch now supports all terminal models.

Only the administrator for the search function of
Atermlnal can use. Even the authorized power
user can not use.

For terminal search feature, if there are users in

he terminal, you cannot change the terminal
ID.
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Managing Authentication Log

RosslarcBio9000 S[=1E3
Fie View Wndow TerminalSettng Tool Help

ROSSINR=

gi®egooo0

StaingDate  ClosingDate  Category Resul Keyword Log: 0

[srsmma =] [ioreane =] [an =0 =T s | Big @

© Schedue Selup

Option Setting
© Timezone Seting

The Authentication Log Management menu can be used to
check data related to terminal authentication.

Select [Authentication Log Management] from the
Information Management window.
Authentication logs can be checked on the List window.

If many logs exist in the database, search conditions can be
used to make searching easier.

Select a category in the search bar near the top of the List
window and enter a keyword. The search results will appear on
the List window.
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To view detailed information, double—click the log, or right—
click the log and select [Properties].

If camera is available, the picture captured by authentication
will be shown as below. User can configure the timing of
capturing through terminal properties menu.

= ‘—'— Detail information about selected auth-log. g

=l

I Information

Log Time : 05/08/2009
User ID : Terminal ID : 100
Authenticate Type : Function Key 0

Authenticate Error :  Failed [0x00000001]  Door error :

I User Information

Authentication :

User Name : Position :
Privilege : Group @
Registered Date : Expired Date :
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You can exngort an authentication log list to a text file or print it out
after click or button.
And also you can set up about print information and item which you

want using a %" button.

4 N

) Only authentication logs of certain users which
—are contained in logged-in Privilege’s user list
will be displayed when logged-in by power user.

'In case of terminal information, although

—authentication has occurred in uncontrollable
terminals by certain users which are contained
in logged-in Privilege’s user list, the
authentication logs will be displayed. However,
terminal related detail will not be displayed
without terminal ID.

\_ 2
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Managing System Log

RosslareBio9000
Fle View Window TerminalSettng Tool Hep

ROSSINR=
BI& 9000
Inf emen

StatingDale  Closing Date Search Type Resut

[or's2m8 =] [ior 82006 =] IR [0

T

me | cinin D | Log Type

5678 FM - Envoll Teminal

0871072018 094521 5678 u
» 08/10/20180.44:25 5678
SystermLog Management ) 08/10/2018 09:44:21 5678
5678
) 08/10/201808.29.32 5678
808 5678

TNA Management

04 152554 5678
© Schedue Setup. 02/10/2018 08:26:43 5678
02/10/2018 08:26:31 5678
02/10/2018 08:25.48 5678

© Oplion Setiing

© Timezane Setting

System logs of program execution items such as user addition
and deletion or terminal connection can be checked.
Select [System Log Management] from the Information
Management window.
System log information can be checked in the List window.

If many logs exist in the database, search conditions can be
used to make searching easier.

Select a category in the search bar near the top of the List
window and enter a keyword. The search results will appear on
the List window.

To view detailed information, double—click the log, or right—click
the log and select [Properties].
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System Log

Detail information about selected system-log.

I Basic Information

Event time :  2/17/2009 7:00:27 PM
Location : AccessManager
AdminID: 0000000

Cateqgory :

Type : RM - User Delete
Error code @ 0x00000000

| Description

{UserID:0033570)
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Managing privilege

The administrator can only access the Privilege Management
menu. The menu is used to set Remote Management program
functions as well as user and terminal authorities.

If the privilege ID defined in the menu is applied, the user will
be given the corresponding level of privilege.

By granting the appropriate authority in the user management
after registering the authority as a new in the authority
management, the appropriate user can be managed as much
as the authority granted.

W BV
RosslareBio9000 WX (P 0 &
Fie_Vew Vindon TeminalSeting Too Hep

ROSSINR=

Bi® 9000
Information Management
@ EwolPiviege [ Priviege Informaton B3 Delete Priviege

o | st

[co]on|on | m ] me | w |me|me | ms |48 |50 (42 (a8 ] o (9] =

[ %] %] o] |28

© Opton Setting
© Tinezone Seting
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e If power users access the Privilege Management menu, they
could check specified authorities which are approved to
them.

(1) Registering Privilege

Select [Manage Privilege] from the Information Management
window.

Click [Enroll privilege]
Enroll Privilege Information &J

h[- E Please enroll sub-admin privilege information.
] Sub-admin have a privilege to allowed users and terminals only

I Basic Information

Privilege 1D n

Privilege Name |

| Privilege Setting

User Management Group Management  Terminal Management Access Management

| Get Info. | Get Info. | Get Info. [ Get Info.
] Add 7] add [ Add [ClAdd

| Update | Update | Update [T Update
[T Delete [ Delete [F Delete [ Delete

| User Management
[] Door Contral

Log Management System Management
[7] Get System Log Info. |"| Export Data
[ Get Authentication Log Info. Import Data

Cw

Privilege ID — Enter an account ID to register as a semi—
administrator.
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Privilege Name — Enter the name of the Privilege to register as
a semi—administrator.

Privilege Setting — Select authorities to make a new Privilege.
(2) Privilege Information

Basic Privilege can be set, and member users and terminals can
be checked or changed.

Select [Manage Privilege] from the Information Management
window.

Double—click the Privilege on the List window, or right—click the
Privilege and select Properties.

« Basic Information Modification — Privilege Name and
Privilege Setting could be modified.
’ Privilege Information (Privilege ID : 11)

“[; Sub-admin privilege information enrolled in server.
|

o BasicInformation | @, User List |E] Teminal List
I Basic Information
Privilege ID "

Privilege Name exp

| Privilege Setting

User Management Group Management Terminal Management  Access Management
Get Info. Get Info. Get Info. Get Info.
Add Add Add Add
Update Update Update Update
Delete Delete Delete Delete

User Management
Door Control
Log Management System Management

Get System Log Info. Export Data

Get Authentication Log Info. Import Data
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« User List Modification — Users who are managed by selected
Privilege would be defined. Only normal users and guests will

be appeared on the list. Power users who have selected
Privilege would supervise selected users only.

Privilege Information (Privilege ID : 7)

------- o
@ Sub-admin privilege information envolled in server. 7 %
@ Basic Infomation | @, User List | Teminal List
I Userlistin the privilege I Available User List for Addition
[EveyUser v [vewuser v][ |[seac]
UserlD & UserName Group ID UserD & UserName Group ID
& 5555 Seen 2 & 3333 Wonki 1
& 6666 Jany 2 Non-Group Numbe| & 4444 Chalie 1
F-¥ecid Fois 0 . 1-Group1
<~ | |2-Group 2
& 8388 Guest 0 - 3. Group 3
< > < >

Users could be found quickly with Group-list Box and Search

functions.
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« Terminal List Modification — Terminals which are managed by

selected Privilege would be defined. Power users who have

selected Privilege would supervise selected terminals only.

Privilege Information (Privilege ID : 7) @

@ Sub-admin privilege information enrolled in server.

I Terminal list in the privilege

@ BasicInformation | @& UserList |E]] Teminal List

I Available Terminal List for Addition

Teminal ID & Teminal Name  Status Teminal D & Terminal Name  Status
(B Terminal 1 Not Connec (Jas 98 Not Connec
(2 Terminal 2 Not Connec (a3 93 Not Connec
(k] Terminal 3 Not Connec (a7 87 Not Connec
B 1 Not Connec
@88 a8 Not Connec
< > < >
Terminal addition complete. (Error Counts : 0)
O LT )
141

Success: 1 Failed : 0

Close
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(3) Deleting Privilege
Registered Privilege can be deleted.

Select [Privilege Management] from the Information
Management window.

Select the Privilege to delete and click [Delete] or press the
<Delete> key on the keyboard.

Or, right—click the Privilege and click [Delete].

Multiple authorities can be deleted using the <Shift> or <Ctrl>
keys.

When one of Privilege is deleted, users who are

A\

~using deleted Privilege would obtain a normal
user Privilege.
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T&A Management

You can manage T&A(Time & Attendance) of registered user
using authentication log generated from a terminal.

Please, refer to “T&A User Guide” deployed regarding details of
T&A.
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Setting Options

Basic server configuration can be done as well as management
program configuration. Menus can be selected using the tabs.

Select [Option Settings] from the Configuration window.
(1) Server Default Setting

Basic options for authentication can be set. The options in this
menu must have the same values as the options of the terminals.

(@ RosslareBio%000 - o X
Fle View Window TerminalSetting Tool Help
ROSSINR=
gescco .. .
ot

@ 4poly

B Server Dk Seting | B Set Mansge Progn
Seltng Secuiy Level AF Card Type
Masimum Fingers (1°2) 11 Secuiy Level (1 =9 AF Card T
(ONLY FOR AY-691:0) bl fiad
R EM - 2661 v
1 R Iput Type
S Timezone Auth
UserID Length (4~ 20) AL -
Use
L o AFF Storsge Opion
Enciypton Type Lini the Peiod of Saving Log Passuord Change Perod
AutoEspot
Communication Encyption O AuitrLog D) @NotUse =
DES v
Ouse Log delete
Anti Pass Back Lovel [ systemLoo 0a) Peiod D2) P —
= I
O High @Low
Sel Sindar FP.
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o Init Setting

Maximum number of fingers to register (1~2) — Set the number
of fingers that each user can register. (This function only
applies to AY-B91x0BT terminals). For AY-B9250BT and AY-
B9350 terminals, up to ten fingers can be registered.

User ID Length (4~20) — Set the ID length between 4 and 20
digits. However, When AY-B91x0BT is used, the ID Length range
will be following the 4 ~ 15.

e Security Level (Default: 7)
1:1 Security Level (1~9) — The user shall input the user ID and
the fingerprint or password to be authenticated. Select a security

level between 1 and 9, with 1 being lowest security level and 9
being the highest.

« RF Card Type

Select the RF card type for user authentication. The RF card type
must be same as the terminal’s setting value.
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e RF Input type

Two kind of RF input type are supported in Bio9000.
One blank for the RF input is provided in [Unified] mode. And
two blanks are provided in [Separated] mode.

When you modify user information, if RF data is already enrolled
and RF option is checked, real data is not removed and you can
use this again when you want to use this authentication type. If
RF option is unchecked, RF data will be removed.

Pop up messase will appear.

If you push the “Yes” button, all of unused RF data will be
removed.

e Encryption Type

Communication Encryption — Refers to the encryption method for
communication packets. DES, AES (128bit), AES (256bit)
encryption is supported.

If the communication encryption is not used, the transmitted
data will not be encrypted.

o Anti-Pass Back level
Refer to [APB setup].

« Password change period

We recommend that administrator’s password have to be
changed periodically.
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If the administrator did not change the password within the
period set, it generates a warning message when you log in, you
put the registration information of the administrator
automatically. (Up to 180 days.)

e Limit a period of saving
It sets up a period of saving about authentication Log and
system log. It deletes authentication log and system log before
set date automatically.
e Time zone Auth

Timezone Auth

You have to set it up to use time zone Use
authentication.

o Auto Export

Authentication log will be saved periodically on the pc where
Access Server is installed

« Delete log

It deletes specified authentication log or system log after select
a date which you want.

e System Log save Option

For the system logs only, you can choose to save the logs you
want using System Log Save Option.
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The system logs are diverse and occur frequently. Therefore,
they need to be saved in consideration of the system capacity.
Choose only the logs you need.

e System Log
Option Setting — Saving of log related to the option setting
Remote Manager — Saving of log related to the Bio9000
User Management — Saving of log related to the registration,
modification and deletion of the user
Terminal Management — Saving of log related to the
registration, modification and deletion of the group
Group Management — Saving of log related to the registration,
modification and deletion of the group
Privilege Management — Saving of log related to the registration,
modification and deletion of the privilege
Door Control — It is an unused function currently.

e TerminalLog

Option Setting — Saving of log related to the modification of
terminal information.

User Management — Saving of log related to the modification of
terminal user

Network — Saving of log related to the connection of terminal
Door — Saving of log related to the door of terminal.

Warning & Error — Saving of log related to the state of terminal.

f 'Log duplication deny — It limits the overlapping
logs, if the same log is sent repeatedly due to an
error in the terminal, not the rejection of log overlap
of the remote administrator.

The logs according to all the operations will not

‘¢reated. Some system logs cannot be created.

b
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e Setting Similar Fingerprint

It checks whether fingerprint image to be enrolled is already
registered or not when a user enrolls or changes own fingerprint.

r N
Set Similar £P. = 53

Init Setting

# of CPU core 2

Similar fingerprint level (1~ 8)

Not Use 6 v

- # of CPU core: You can see it when the system has multi-
core CPU. More higher this number, speed to search
fingerprint faster but load of system might occur.

You can change this option in “"ACServerConfig.ini”. If this
option is changed, you have to re-start Access Server
Service.

You can set it up as follows.

A

- Similar fingerprint level: it set up threshold value to identify
fingerprint. You can choose 1~9. It is higher, security level
is high.

-

enrolled to check similar fingerprint.

Alt uses system memory as many as fingerprint is

It may cause load of system.
We recommend that you use the eNBio-MAS to use

1:N Identification on server side.
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¢ SOC Setting
Setting value should be defined correctly to issue the card and
authentication. This value must be same with the value which is

configured in NBioRFCardManager installation menu.

This item will be displayed on the SOC mode.
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(2) Setting Management Program

The Bio9000 program can be set.

RosslareBio9000 =1 E3

Fle Vew Wndow TemialSeting Tool Hep

ROSSINR=
T R
@ fonly
@ Servet Defat Seting | G2y S Marige Piogam

TNA Management

1 LogListOpton
© Sehed Condiion (1~ 100 Daye) €
ondiion 1~ 1000 Daye) e
O Sched Log Numbers 100 ~ 30.00) 3
 Sched Tl 0060 |
1 Commuriaton T Links (25~
Input T LiitsBetween Remoe Manager o Server & =
1 Sersor Seing
SetBightness ofthe Sensor Sensor Opton
1 oot Contl
[p—— o
Opion Seting .
© Tinezons Seting ™
TNA Management O NotUse  MealService Management O NotUse

1 Auth Log Nty Option

Ouse bellwav. 5

o User options

Save User ID for Login — Administrator ID for the Bio9000 is
automatically saved.

ID Auto generation — Available user ID is generated

automatically.

Set Language — You can select the language you want in the
Bio9000. (English, Korean, Japanese, Spanish, Portuguese, Thai)
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e Log List Option

The size of the log display (by date and items) in the
Authentication Log Management and the System Log
Management menus can be configured.

Log Search Condition (1 to 1000 days) — The default search
period can be set. (Default: 30)

Maximum Log Number (100 to 30,000) — The number of
search results shown on the log list can be configured.
(Default: 30,000)

e Communication Time Limits (5 ~ 60 Sec)

A communication timeout can be set between Remote Manager
and the main server. (Default: 25) (Setting of Terminal Type: for
AY-B9350, it is 5-60, and for AY-B91x0BT, it is 25~60).

If there is no response within the specified time, the network
will be seen as disconnected. If the network environment is
poor, lengthen the timeout period.
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e Door Control

Terminal Status Alarm: It notifies a terminal status of whether a
door is opened or not via a message box. This message box
disappears after set time automatically. Unit is second, default
value is ‘0’ and message box is not displayed.

e T&A management and Meal service management

You can set up whether you use Time&Attendance and Meal
service or not. If you don't use it, these item are not displayed.

AMeal management service is available in function-
“key supported terminal.

« Verification log notification

Check [use] to notify occurrence of verification log at terminal
with sound. If Wav file is designated, notification will be made
with the designated sound. If option is changed, Remote
Manager must be restarted.

ﬁMusic files of some formats may not play.
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Setting Time Zone

Time zones can be set to manage access periods, restricted
periods, and door opening periods.

Click [Setting] [Time zone Setting].

The time zone list will appear, and tabs can be used to check the
holiday list.

RosslareBio9000
Fle View Wndow TerminalSettng Tool Help

ROSSINR=

BB Timezone Seliing 3} Modify Holiday List

@ TinezoreList | @ Holday Lis

1 Version 0

I Timezone List 1 Hoiday Information

N e Holdey st Code |3 [l Fobdey List. |

Holiday

Tue.
Wed
Thu

Sat

Sun.

(1) Time Zone List

The list of currently registered time zones can be checked.
Select a time zone from the list to check the range of the time
zone.
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e Setting Time Zones

Select the [Modify Holiday List] or double—clicking a
registered time zone to set that zone. By setting a time zone,
user access in certain times can be allowed or denied.

Enter the time zone name, select the holiday code, and set
access—permitted times, access—denied times, and times when
the door is always open for each day.

As shown below, select an access—permitted time, access—

denied time, or door—open time, and click on the desired time
and drag.

I Timezone Information
Holiday List

Timezone Code @ Access Denied

[
Timezone Name [ Access Allowed

Holiday Code Not Selected = (] Opened
N L ) 07 ) ) ) 0 4 ) G L B B
VS 1 1) 07 5 5 5 ) ) 0 ) B B 2
Tue. [00)[01][02] 03] 04| 05)[ 06][ 07] 08| 03] 10][11][12][13][ 14| 15][16][17][18][13] 20][21][22] 23]
Wed, [00] 01][02][ 03] 04]  05] 05][ 07 03] 03] 10][11)[12] 13] 1] [15] 16][17) 18][18] 20][21)[22] 23]
Thu, [00][01)[ 02 03] 04][ 05] 06][ 07| 08| 03] 10] 11][12]| 13| 14| 15] 16][17][ 18] [ 19] [ 20][21][22] 23]
I 1 2 5 5 5 ) ) 5 ) ) X 2
sa [00]01)[02)03][04][05|[06 o7 0o| 09| 40| 4] 2] 3] a| 5] 6] 7] 5] 5] 20 21| 22|z}
Sun. 00][ 01][02][ 03| 04][ 05 06][ 07| 03] 03] 10][11][12] 13| 1] 15 16][ 17 18][13] 20][21)[22] 23
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You have to drag on the time-set table clicking left mouse
button after clicking authentication type such as “Access
Denied”, “Access Allowed”, “Opened”, and “Auth Type”.

« Time Zone Display

Access—denied times are displayed in red, access—permitted
times in yellow, and door—open times in blue.

The above picture example, holidays from 3am to 6:59am,
region which is on Monday at 5:00pm to 7:59pm with marked in
red and the other day by the time zone is built, separated by red
and yellow.

The time zone of the red area to a successful authentication is
not allowed to even approach the time zone of the yellow area.
If successful, the authentication means only to allow access. In
addition, the region marked in blue if the door will be always in
your time zone.

To use minute’s time zone, more than two blocks of [Access
Denied] or [Opened] are required. How to use: In the time
zone, the Settings, if the mouse cursor is put over the red or
blue block, right click the mouse. Then, setting time in minutes
will be available.

The following image is the screen which sets minute’s time zone
in the not access block.
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Time zones can be set according to user, terminal, or a
combination of both.

If a combination of time zones is used, the priority will be as
follows:

Authentication time-zone is available in AY-B91x0BT.

/ 3Priorities by Time Zone Code

~— Door-opening Time set in the terminal >
Holidays set in the terminal > Regular days set
in the terminal > Holidays set for the user >

Regular days set for the user

Even if the time zone code of a user allows door
access, the user cannot enter if the time zone
k code of the terminal does not allow access.

'Authentication time-zone operates in case of
terminal time-zone. It can’t be used in case that time-

zone is set in the user properties.
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I he terminal supporting the authentication time
zone is AY-B91x0BT or AY-B9250BT.

(2) Holiday List
Display the list of holidays in the time zone.
One list may have multiple holidays. The holiday list can be

edited by double—clicking item on the [Holiday List] or click
[Modify Holiday List] button.

« Holiday List Modification

Multiple holidays can be selected and registered to a single
holiday list.

Enter the holiday list name and select the date in the date
selection window. Double-clicking item or click [Select] button
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to include the date in the holiday list. The holiday code will be
given automatically.

The user can add up to 30 dates to a single holiday code.

To delete a date from a holiday list, select a date and click

[Delete].

Modify Holiday List

!

I Holiday

Holidsy Code |1

I Holiday Setting

Holiday Name | Holiday

SECURITY PRODUCTS

Apiil, 2009 E';"do"‘; L%
Sun Mon Tue Wed Thu Fri_Sat 03-19

1 2 3 09-17
s s Elle 3 10 1 [Delete] | 03-26
12 13 14 15 16 17 18
19 20 21 22 23 24 25
% 27 28 29 30

0K ] [ Cancel J
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Setting APB

Antipassback (APB) is a feature that blocks the exit of users
who were not authenticated when entering. This is useful for
areas requiring high—level security.

All visitors must be authenticated when entering or exiting.
In area—based APB, a user who was authenticated in a certain
area when entering must be authenticated in the same area

before he can go to another area.

If the user moves to another area without being authenticated,
an APB error will occur.

o APB Concept

External Terminal 2
area
(Zone I~
1) Term 2 area
inal 1 (Zone ID 2)
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In the above figure, Terminal 1 is an exit from Zone 1 as well
as an entrance to Zone 2.

Terminal 2 is an exit from Zone 2 and an entrance to outer
area.

To apply the APB feature, exits and entrances must be set for
each terminal. If entrance and exit terminals are specified for
an area, each terminal must have at least one corresponding

terminal.

The above figure is the simplest example of APB, and more
terminals can be set in more areas.

From the user’s perspective, the default APB value is 0. If the
user enters Zone 2 through Terminal 1, the APB value will
become 2 (zone ID value). If the user is not authenticated by
Terminal 2 when exiting, an APB error will occur. If the user
exits through terminal 2, the APB value will become 1.

ij- he setting of Anti-Pass Back is a function that the
—administrator only can use.
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e Zone Setting

Select [Tool] > [Anti-Pass Back Setting] on the menu bar.

RosslareBio9000

 File View Window Terminal Setting TooIhHelp

ROSSLARE | e

Export Excel,CSV(X)

Bl& S000 =

Information Management

Export User.
B User Management Import User.
Group Management Pmes
Terminal Management I
Anti Pass Back Setting. |

8 Access Management
Auth. Server Sync. list
Auth-Log Management
Set Language

System-Log Management E ZaTIZT 20T TZ U S0

Anti-Pass Back Setting @

I Anti-Pass Back Temminal Select

Teminal ID  Terminal Name Entry zone Exit zone Result
1 Terminal 1 Init value Init value
2 Terminal 2 Init value Init value
(555 Terminal 555 Init value Init value
(@000 Main Terminal Init value Init value

[ Initialization ][ Set Entry Zone ][ Set Exit Zone ]

[SettingZone]E Apply J[ Cancel ]
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Click the [Setting Zone] button then activate the following
window for zone editing.

Anti-Pass Back Zone Information @

I Anti-Pass Back Zone Information

Zone ID Zone Name

0 Init value

1 Qut door Zone
2 Zone 2

3 Zone 3

4 Zone 4

5 Zone S

Add ” Update l[ Delete l

Close

When a zone registration window opens after clicking [Add],
please type in zone ID and zone name to proceed. As ID 0 and
1 is a default zones, you cannot modify or delete it.

When zone registration is done, please select terminals for
each zone. After clicking target terminals from <illustration 1>,
please set entrance and exits for each zone by clicking relevant
buttons
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I AntiPass Back Terminal Select

Teminal ID Terminal Name Entry zone Exit zone
B1 Teminal 1 Init value Init value
2 Terminal 2 Init value Init value
(555 Teminal 555 Init value Init value
ZUDU Main Terminal Init value Init value

Setting Zone

Reg | Anti-Pass Back Zone Information

Zone ID
1]

Qs wN e

(

Initialization ]I Set Entry Zone "_S

Zone Name
Init value

Out door Zone
Zone 2

Zone 3

Zone 4

Zone 5

ooz

When you set entrance and exit to zones, you will have the
following screen.

Anti-Pass Back Setting @

I Anti-Pass Back Terminal Select

Terminal ID  Terminal Name Entry zone Exit zone Result
1 Terminal 1 Zone 2 Zone 3 Success
2 Terminal 2 Zone 3 Zone 2 Success
(<555 Terminal 555 Zone 4 Zone 5 Success
(2000 Main Terminal Zone 5 Zone 4 Success
[ Initialization ]l Set Entry Zone " Set Exit Zone ]

l Setting Zone ”

goply || Cancel |
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Please click an [apply] button to complete the setting.

1. Please make sure that you select an exit
when you selected an entrance to a zone.

2. Please make sure that you select an
entrance when you selected an exit to a
zone.

3. Please do not select the same values for an
exit and an entrance to a zone.

4. For an unregistered terminal, the setting
cannot be made. Please, be sure to apply it
after the registration.
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e APB Level

The APB feature works on the network and the terminals in the
relevant areas must be connected for the feature to work.

The following policies exist for the APB feature:
Anti-Pass Back Level — Low

If the terminal at the zone exit (or entrance) is disconnected
from the server or is malfunctioning, the user may be
prevented by the APB settings from passing any exits.

If the Anti-Pass Back level is set to low, the user can exit
through the door of any zone if a network fault occurs.
(Default)

Anti-Pass Back Level — High

If the terminal at the zone exit (or entrance) is disconnected
from the server or is malfunctioning, the user may be
prevented by the APB settings from passing any exits until the
network connection is restored. Therefore the settings should
be given close attention.

/

~

'Even though the setting of Anti Pass Back was made to
“High”, if the authentication is succeeded at the
entrance or exit terminal before the connection is
broken or the abnormal state, in the case of connection
of opponent’s (Pairing) terminal of Anti Pass Back, the
first attempt at the authentication will be succeeded.

J
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« Initializing User Data if Error Occurs

Select a user management item from the Information
Management window. Right—click a user on the List window
and click [Initialize APB Status]. Then, the door will open
once regardless of the APB setting.

RosslareBio9000

: Fle View Window Terminal Setting Tool Help

ROSSINRR=

BI#9000

User Management Type Keyword

Group Management IEVS"' User LI |

Terminal Management UserID - | User Name | Privilege
Access Management 801234 inbn_smith Mastar

Properties.
Authentication List
Setting time-zone code for each user.

Auth-Log Management
System-Log Management

Privilege Management

@ Delete
Option Setting Initialize APB Status
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Downloading Logo/Wallpaper

The LCD screen of terminal to specify the logo/wallpaper image
can be downloaded.

Select [Terminal Setting] > [Download Logo/Wallpaper]
on the menu bar.

Logo/Wallpaper Downloads (]

I Teminal Logo ——————————— | Available Teminal List [~ SelectAll

Load image...

A resolution of the image stored in the terminal
is 4807272

If the image resolution is different with a
default resolution, it may have some distortion.

| | |

User can select the terminal device to which logo or
background image will be applied on the applicable terminal
device list screen and designated the file path to be used as the
background image for the terminal device by clicking the

[Load Image] button.
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Logo/Wallpaper Downloads x|
I Terminal Logo | Available Terminal List
Temninal ID_| Teminal Name:
Load image...

A resolution of the image stored in the terminal

is 128160

If the image resolution is different with a

default resolution, it may have some distortion.
«| | i

Cancel Apply

Selected images have previewed to adjust to fit the screen size
as upper.

Click the [Apply] button, selected image is applied to terminal.

For AY-B9350, when you applying it in the background, select
[Terminal Properties] -> [Display] -> [Background
image] -> Custom Image to apply the selected image in the
desktop.
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Downloading Firmware

Firmware can be downloaded to each terminal.

Select [Terminal Setting] > [Update Firmware] on the
menu bar.

Or, right—click the terminal and click [Firmware Download].

Firmware Updates x|

I Available Terminal List AY-BI350 [~ ™ Select Al

Teminal ID_| Terminal Name | Firmware Ve... | Result

<« | =
[

I Set Fimware Path

Path
fiesly

Set the device type and select a terminal and specify the
firmware path. Then click the [Apply] to download the
firmware.
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Log Management

Authentication logs could be imported from terminals.

Select a terminal on the Terminal Management Window. Then,
right-clicking and select [Log Management].

Log Management x|
I Available Terminal List [~ Select Al
Terminal ID | Terminal Name | Firmware V... | Result
! test 2,003 - 0055

Log count | Log get | Log delete | | Close I

Log Count — This function will display a number of logs which
are stored in selected terminal.
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Log Get — Logs which are stored in selected terminal will be
saved in database.

Log Delete — All logs of selected terminal will be deleted.
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Users which are stored in selected terminal will be saved in
database.

Select a terminal in Terminal Management Window. Then right-
clicking and select [User Restore].

The progress of restoration will be displayed.

&'Synchronization all' should be executed for the

terminal after user restoration.
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Door Control

Doors can be controlled by this function.

Select [Terminal Setting] > [Door Control] on the menu

bar.
I Available Terminal List I~ Select Al
eminal ID_| Terminal Name | Fimware Ve, | Resut |
O 4 test 2.003 - 0055
< | 2|
Select Door
& Door1 Open Door
 Door2
 Door 3
Close Door
" Door 4
Close |

Administrator can control each doors through [Open Door]

and [Close Door] button.
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Synchronization

When user group and time zone information is changed in the
server, the corresponding information in the terminal will also
change.

If user information is incorrect due to network problems,
synchronization list error, user count error, or time zone version
error may occur. Synchronization is needed to prevent these
errors.

Select a terminal where a synchronization error occurred, and
choose [Terminal Setting] > [Run Synchronize] on the

menu bar.

Or, right—click the terminal and click [Synchronize].

Synchronize g]
I Basic Information
Terminal ID: 2000
I Error Detail
MNumber of Users [[] synchronize List
Server User : 6000 Number of
Synchronize List : 0
Terminal User : 4008
Synchronize(S) Close {C)

Select the Terminal Management menu from the Information
Management window and check the synchronization error and
status of each terminal.
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e Error

If a synchronization error occurred, the cause of the error can
be checked.

Time Zone — When the time zone settings of the server and
terminal are different.

Number of Users — When the user counts are different.
Synchronization List — When the user information of the
terminal and server are different.

Click [Detail]. Then a list of servers and terminals that do not
have the same user information will appear as shown below.
Even the number of users saved in the server and the number
of users saved in the terminal is same, but the users saved
may be different.

(Master: 1, User: 2)

Server User 6000 Terminal User 4008
User ID Master  Group ID N User ID Master  Group ID N
0000000 1 o 0000001 1 o
0000001 1 o 0000004 2 o
0000002 2 o 0000012 2 o
0000003 2 o 0000014 2 0
0000004 2 0 0000015 2 ]
0000005 2 0 0000016 2 0
0000006 2 o 0000017 2 o
0000007 2 o 0000018 2 o
0000008 2 o 0000019 2 o
0000009 2 0 0002001 2 0
0000010 2 0 0002002 2 0
0000011 2 o 0002003 2 o
0000012 2 o 0002004 2 o
0000013 2 0 0002005 2 o
0000014 2 0 0002006 2 0
0000015 2 0 0002007 2 0
0000016 2 o 0002008 2 o
0000017 2 o 0002009 2 o
0000018 2 o 0002010 2 o
0000019 2 0 0002011 2 0
0000020 2 0 0002012 2 ]
0000021 2 0 0002013 2 0
0000022 2 o 0002014 2 o
0000023 2 o 0002015 2 o
0000024 2 o 2 0002016 2 o v
nnnNnNos 2 n annnnes 3 o
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General Synchronization

All user information can be synchronized between the server
and the selected terminals.

By completely synchronizing user information, any problems
related to synchronization can be resolved.

Select a terminal with a synchronization problem, and select
[Terminal Setting] > [Synchronize All Data] on the menu
bar.

Or, right—clicking the terminal and click [Synchronizing all].

The following message will appear. Click [Yes] and conduct
general synchronization.

AccessManager

D) All users in the terminal will be initialized and synchronized to server settings.
.
This job might take several seconds to a minute depending on user count in the terminal. Do you want to continue?

Select the Terminal Management menu from the Information
Management window. The terminal list will be displayed.

AT he synchronization of terminal is a unique
= authority of the administrator, and even the

power user with an authority for terminal control
cannot synchronize.
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The status of all terminals registered in the server and user
authentication logs can be monitored in real time.

Select [Tools] - [Monitoring] on the menu bar.

a

Normal Terminal | 1it. Warning Abnormal Terminal

- B} me Normal Bl open [ open [ Closed [ Closed - - Base 1 Not Conn...
[Bo101 1 Not Conn.
3101 of Not Conn...
111 enCard Not Conn...
=63 123 Not Conn...

< >

From this point of time, all authentication results will be shown
on the [Monitoring] screen. If warning status activated in
normal terminal, the terminal color is changing to red. Also,

terminal status can be restored to normal through [Init
Warning] button.

You can see details of log data after you double-clicked a log in
the list.
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With the input of door-open status sensor (DOOR STATUS
SENSOR), it displays the door-open status (open, closed).

DoorOpen: Displays Always open the door.
DoorWarning: Indicates when door is forcibly opened.
Fire: Indicates a fire.

Panic: Displays when a panic condition occurs.
Temper: Displays when temper warning occurs.
Warning: Shows when other warnings occur.

You can double-click the log in the list to view the details of the
log.
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CSV Export

The lists displayed on the Information Management window can
be exported in CSV format (*.csv).

RosslareBi09000 W P
Fie Vew indow TemindSeting Tool tep

ROSSLNAR=
B/& 9000
Infol n Me ement

[Every User =0
| UserID_ | User Name | Piivilege.
Sa123 fohn snith Master

For example, the user list can be exported as CSV file by clicking
[User Management] on the Information Management window
and clicking [Export CSV].

Select [Tools] > [CSV Export] on the menu bar.

CSV file is a text—based format. User can read this file though
Notepad.

Lists that can be exported as CSV files: Users, Groups, Terminals,
Authentication Logs, and System Logs.
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AT he “"CSV” file shall be saved after deleting the
= comma (%,") by the nature.

As “CSV" is saved as the ANSI type, it does not
= support the language in Unicode format.
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User can save the user data into USB memory and hard disk by
selecting the user data registered in the server.

Execute for this function, select [Tool] > [Export User] on
the menu bar.

Export User

I User List
UserID & User Name Priviege  Authenticate Type Grou,..  Time... FP.Count Position A
0000000 Normal ... PW a 0
0000002 Master FP{PW (AND) 0 0 4
0000003 Master  FPJPW (OR) 0 0 4
0000004 Master FP{PW (OR) 1] a 4
0000005 Master FP{PW (OR) a a 6
0000006 Master FP{PW (OR) a 1] 6
0000007(DT) Master FP{PW (OR) 1) a 4
0000008 Master  FP{PW (OR) 0 0 4
&7 oooooog 0000009 Master  FP{PW (OR) 0 0 4
E 0000010 0000010 Master FP{PW (OR) 0 0 4
: 0000011 0000011 Master FP{PW (OR) a 1) 4
; 0000012 0000012 Master FP{PW (OR) o ) 4
|| 0000013 0000013 Master FPjPW (OR) a ) 4
[] ooooot4 0000014 Master  FP{PW (OR) 0 0 4
] ooooois 0000015 Master  FPJPW (OR) 0 0 4
: 0000016 0000016 Master FP{PW (OR) 0 0 4
: 0000017 0000017 Master FP{PW (OR) 1) a 4
: 0000018 0000018 Master FP{PW (OR) a 1) 4
: 0000019 0000019 Master FP{PW (OR) a 1) 4
[] oooooza 0000020 Master  FP{PW (OR) 0 0 4
[ ] oooooz1 0000021 Master  FP/PW (OR) 0 0 4 2
Selected user count : 9/ 100000

On the above screen, select the user to download to USB
memory and press ‘Select’ button to check it.

After that, selecting [Export] button will bring the following
image and ask the file name to be saved.

5If the file name is changed, the terminal device
—cannot read file. So, it is recommended not to

change the file name.
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§ico Cau ) (e e ]
[PSW N Open @@ ~
000000 1 =
Lookin: | 3 My Computer v > -
000002 J ‘ 0 m
1000003 5 J4 34 Floppy (A1)
000004 £ ) e Local Disk (C:)
000005 MyRecent | Workspace (D:)
000006 Documents  |<e Storage (E:)
000007 — 2 DVD-RAM Drive (F:)
000008 @ 2DVD Drive (G:)
0000003 Desktop || < Remavable Disk (1:)
[] oooooto
] ooooot1
] ooooo12
[ oooons My Documents
] ooooo14
] ooooo1s R
] ooooo1e [}
-
] ooooo17 Jr!
] ooooots My Computer
[] ooogo1a - v
[] oooooz0 \,’] File name: 225000 usercb_up.nab) v
] oooaoz1 D v
R My Network  Files of type: | AC user data File (*.ndb) v Cancel =
Tomot ]

Save the file by making file name to be saved and pressing the
[Open] button.

If save command is successfully completed, the screen will be
showed up as follows.

When the user exported, user privilege will be set

‘L\to the [Normal User].

'You have to use a “user exporting” function after
%ou stop other process”

t the User Export, the deselected authentication
“method that will not be released (however, the
password is saved).
At the User Export, the Version 3(Face) saves up to
‘the FACE template.
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User can import user data saved in USB memory and hard disk
to save in server.

Execute for this function, select [Tool] > [Import User] on
the menu bar.

Firstly, set the file path. Then, select the file to import and press
the [Open] button to import the file.

When the file is loaded, the user data loaded will be displayed as
follows. Among the accounts, selected the account to register in
the server and select by [All], [Check] or [Uncheck] button.
Then clicking the [Upload] button will register the selected
accounts into the server. The default is selected all.

Header Info
Version: 1 Template per FP: 2
ID Length: 7 User Count: 601
User ID & User Name Authentic... Grou... RFCardNumber Secu... Gain Bri.. Co.. Timezo... FP.Count Result ~
E 0000000 Admin FR/PW/RF ... 1000 3926400270 7 2 40 20 0 2
E 0000001 L2 +RF FPJRF (AND) 1000 2062817806 7 2 40 20 0 2
E 0000002 RF RF 3000 571671891 0 0 0 0 0 0
E 0000003 P3 PW 3000 0 1] 0 0 0 0 o0
E 0000004 Guest L4 FP 5000 0 (1] 0 0 o0 0 2
E 0000005 R2 +RF FP/RF (AND) 2000 2719155539 1] 0 0 o0 0 2
E 0000006 R34+ P6 + RF FRIPW/RF ... 2000 1645413715 1] 0 o0 o0 0 2
E 0000007 R4 or P7 or RF FRIPW/RF ... 2000 3269198931 1] 0 o o0 0 2
E 0000008 Guest P8 PW 5000 1] 1] 0 o o0 0 o
E 0000009 P9 PW 3000 o o o 0 0 o 0
E 0000010 PO PW 3000 o o o 0 0 o 0
E 0000011 Re-L1+P1+.. FP[PWIRF 4000 3792897363 3 2 40 20 o 2
E 0000012 Re-LSor P2... FPPW/RF 4000 3526755667 o o o o o 2
E 0000013 Re -R1or RF FPIRF (OR) 4000 2733048915 i} o 0 o o 2
E 0000014 Re - P4 +RF PW/RF (A... 4000 1645479251 0 0 0 0 0 0
E 0000015 Re-PS PW 4000 0 0 0 0 0 0 0
E 0000016 Re-P6 PW 4000 0 0 0 0 0 0 0
E 0000017 Re-P7 PW 4000 0 0 0 0 0 0 0
E 0000018 Re-P8 PW 4000 0 0 0 0 0 0 0
E 0000019 Re-P9 PW 4000 0 1] 0 0 0 0 0
’E 0000020 Re - PO PW 4000 1] 1] 0 0 0 0 o v
Selected user count : 601 [ 601

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 187

When update command is successfully completed, the screen
will be displayed to indicate the progress results.

AUser data can be created in the terminal device.

When user data transferred from a terminal by

Export User] are brought to another terminal
by [Import User], the user’s authorized login
period expires

When importing CSV, which includes “0” in front
f the contents, go to [Format Cells..] >
[Category] > [Text] and edit and then save.

Import Log

Execute for this function, select [Tool] - [Import Log] on the
menu bar.
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Firstly, set the file path. Then, select the file to import and press
the [Open] button to load the file.

When the file is loaded, the log data loaded will be displayed as
follows. Among them, selected log data to register in the server
and select by [All], [Check] or [Uncheck] button. Then clicking
the [Upload] button will register the selected log into the server.
The default is selected all.

Header Info
Version: 1 Terminal IID: 101
Log Type: NOT SEND LOG Log Count: AUTH [4]/5YS [0]/ TOTAL[4]
Time & User D Authenticate Type Authenticate Result Function Ke... Transfered |
[ 1sjos2009 11:15:29 Fingerprint (All) Failed No |
[ 1sjost2009 11:15:33 Fingerprint (All) Failed o
M 1sjost2009 11:15:42 Fingerprint (Al Failed No
M 1sjos2009 11:15:45 Fingerprint (All) Failed No
Selected log count : 4 / 4

When update command is successfully completed, the screen
will be displayed to indicate the progress results.

AccessManager, @

°
\l) Log upload completed.
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m Bio9000 Information
The version information of Remote Manager can be checked.

Select [Help] - [Bio9000].

. RosslareBio3000
Product Version: 2. 1. 9.0

File Version: 2. 1. 6. 86

Copyright 2009 license Info
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Setup Wiegand

¢ Introduction

If using an external device such as Wiegand card reader or
controller, etc. by connecting to the terminal, input the setting
value. The user can set for the Wiegand input and Wiegand
output. Not only the standard 26 bit, 34 bit, but also the
Wiegand settings of various user environment are possible. In
addition, parity, bit, digits and also the data field, etc be
specified to fit user environment. The followings are how to set
the Wiegand output.

AAY-89350 is only available for use.
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e Set Wiegand Out

Code User Name Basic Information
Bit Length Custom Size |0
Send Fail Fail Data [0
Output Type Interval Time(us) 0
[ Send to terminal ] Width Time(1s) |0
Information Set Field
Code T rrrrrs g
O . B
49 64 @
SR
« OO0 00> o
I =
ws OO0 O0 OOOOO000 w2

1 DDDDDDDD OO0
v OO0 OO0 =2
EE I O
« OO0 OOOECEE s+
ss [0 OO so
st OO0 OO s
o OO0 OOOOO00T e
us OOODO0O0 OOOOO000 =

Bit Length: Length settings

Unused: When Disabled.

St. 26bit: When the standard 26bit

St. 34bit: When the standard 34bit
Customize: Users when any designated date

- Port State: Active Low(Basic) / Active High

Send Fail: Authentication success signal

B Not Anything: When Disabled

B Send Fail Data: failure signal will be sent

B Invert Parity: Failure signal transmission E/O as
opposed to output (E: Even Parity / O: Odd Parity)

- Output Type: Select Output type (UserID / Card Serial)
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- Custom Size: settings is Bit Length — [Customize] then
Length select ( Range: 1~128bit )

- Site Code: if necessary, user settings (Settings range from
the terminal: 0~255)

- Fail Data: settings is Send Fail — [Send Fail Data] then Fail

Data format input
(Tip: Fail Data If you enter “1234”, 1 = Site Code / 234 =
UID)

- Interval Time(us): 0 (if you do not set, Usually 2ms)

- Width Time(us): 0 (if you do not set, Usually 50 S )

- Set Field: Field Type value set to the right, select the item
and to specify one.

[S]: 1byte (= 8bit)

[BJ: yser ID data, Specifies the length of digits

|0 : Data value to 0 if you need to specify a fixed

|1 : Data value to 1 if you need to specify a fixed

[OJ; Verify the accuracy of add bit

[EJ. Verify the accuracy of even bit

- Set Parity
B Verify the accuracy range of Even Parity and Odd Parity
(Tip: 26bit = Except for Even Parity, 12bit Specify + Except
for Odd Parity, 12bit Specify)

ROSSILNR=

SECURITY PRODUCTS



RosslareBio 9000 Software Guide 193

o Set Wiegand In

Code User Name Basic Information
portsate interval Tme(us) 0
Send to terminal I Width Time(us) 0
Set Field
0 unused
o P
Information 17 L [N | 32 U
code [0 3 | I O js [ codvee
o OO [N Jes [3] cordpatas
Neme es LI IC I I |0 [4) cardpatas
o« OO0 000000 * [ cocoens
Add o7 OO O | 112 @
Update s OO [ ] 128 &
Set Parity
+ LE e O] e E"‘?fﬂf”e
w7 OO O] s o=
= 000000 00000000 ogesee
< OO OO s
es [ O] e
s OO0 OO0 0 * o
B o
s OO0 O

- Bit Length: Length settings

®  Unused: When Disabled

B St. 26bit: When the standard 26bit

B St. 34Bit: When the standard 34bit

B Customize: Users when any designated date

- Port State: Active Low(Basic) / Active High

- Custom Size: Settings is Bit Length - [Customize] then
Length select ( Range: 1~128bit )

- Interval Time(us): 0 (if you do not set, Usually 2ms)

- Width Time(us): 0 (if you do not set, Usually 50~100 [S)
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- Set Field: Field type value set right, select the item and to
specify one.

1. Input Data 1

2. Input Data 2

I3: Input Data 3

[4]. Input Data 4

5. Input Data 4

[OJ; Verify the accuracy of odd bit

[EJ. Verify the accuracy of even bit

- Set Parity: Verify the accuracy range of Even Parity and Odd
Parity
(Tip: 26bit = Except for Even Parity, 12bit Specify + Except
for Odd Parity, 12bit Specify)

- Data Type: Card Data Specifies the type specified in the [Set
Field]
B Unused: When Disabled
B Binary: When Binary
B Decimal String: When Decimal
B Hexa String: When Hexa

- Digit Size

- Order: Data transmission
B MSB: Sequential Transfer
B LSB: Reverse Transfer
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Chapter 5
Appendix
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m I cannot install SQL Express.

SQL Express is a free database program distributed by
Microsoft. SQL Express may be having installation problems
due to system specifications. The system requirements
recommended by Microsoft are as follows:

— 0S: Windows 2000 Service Pack 4; Windows Server 2003
Service Pack 1; Windows XP Service Pack 2

— Intel or Pentium III 600MHz or equivalent processor (of 1GHz
or higher)

— Minimum 192MB RAM (Minimum 512MB is recommended)

— 525MB of hard disk space

Note: The user must have Privilege over the PC in which SQL
Server Express will be installed. Install the following files before
installing SQL Express.

(1) Download and install Windows Installer 3.1.

(2) For a 32-bit platform, download Microsoft .NET Framework
2.0 32-bit version. For a 64—bit platform (only for X64 and
EMT64), download Microsoft .NET Framework 2.0 64-bit

version.

(#) Install the SQL Express.
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m If Message of "Wrong user or Can't connect to DB” is popped
up while installing Bio9000

Run SQL Server Configuration Manager in Start program >
Select SQL server service in the left menu - Double click SQL
Server Browser in the right list > Click [start] button in
properties pop up to change service into running status and
then continue installation
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m The terminal or Remote Manager is not connected to Access
Server due to Windows firewall settings.

Select Control Panel and double—click [Firewall]. Select the
[General] tab and click [Off]. Or select the [Exceptions] tab

and add ports for Bio9000 and the terminal by clicking [Add
Port].

Bio9000 Port: 7331 (Default)
Terminal port: 7332 (Default)

i o )

General | Exceptions | Advanced| General| Exceptions | Advanced

Windows Firewall helps protect your computer by preventing unautharized users Use these settings to open a port through Windows Firewall. To find the port
from gaining access to your computer thiough the Intemet or a network numkblel and protocal, consult the documentation for the program or service you
want to use.

@ © 0n (recommended)

This setting blocks all outside sources from connecting to this Name: |AccessManager
computer, with the exception of those selected on the Exceptions tab.

Port number: | 7331

low e

@®TCP Oubp

Select this when you connect to public networks in less secure
locations, such as airports. You will not be notified when Windows

Firewall blocks programs. Selections on the Exceptions tab willbe | ot cee the ks o opering a o2
ignored e s wamia

@ @ Off (not recommended)

‘Avoid using this setting. Turing off Windows Firewall may make this [addPogam. | [ addPor. J [ Ea. [ Dokt |
computer more vulnerable to vituses and intruders.

Display a notification hen Windows Firewal blocks a program

What else should | know about Windows Firewall?

What are the risks of allowing exceptions?

m In case of changed the AccessServer IP and DB Server IP
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You can change easily both of IPs Bio9000 and DB Server when
its IP changed or reassigned by DHCP Server.

(1) Exit to Running AccessServer
Windows Control Panel - Administrative Tools - service
Item double—click > Stop after selecting [AccessServer
Service] in the list of services.

(2) Go to the path C:\Program Files\ RosslareBio9000 and open
the [ACServerConfig.ini] file using notepad.

(3) In contents of ACServerConfig.ini file, close the file and save
after entering the changed IP in the [SERVER_IP] or [DB_IP]
item.

B ACServerConfig.ini - Notepad

File Edit Format View Help

|[[CONNECTION_SETTING]
SERVER_IP =172.16.0.155

(4) AccessServer again to re—run.
m How to back-up SQL Database?

You can back-up current database through Microsoft SQL Server
Management Studio Express

(1) Terminate AccessServer
Start > Control Panel - Administrative Tools = Service >
Terminate AccessServer.

(2) Excute the Microsoft SQL Server Management Studio Express.
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(3) Connect to DB.

o =
Mgy Microsoft

Microsoft

SQL Server 2005

Database Engine
Server name: 192.168.10.48

Authentication: [SQL Server Authentication

Login: sa
Password: =
["] Remember password

[ Comect || Cancel || Hep

(4) Confirm the location of the database file after connection.
Bio9000 (Right-Click) — Properties
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Select a [Files] Tab.

(5 Bio9000 (Right-Click) — Tasks — Detach

Click [OK].

(6) Copy Data File (mdf) and Log File (Idf) to new folder from the
path which is checked at (4) to back-up current database.

(7) Databases(Right-Click) — Attach

’.\\ Microsoft SOL Server Management Studio Express

File Edit View Tools Window Community Help

Dnewquery | [y | H @ | B EH B s = <

Object Bxplorer - & x Tl
ETETIENEN « PYEr=a
= [ Y 192.168.10.45 (SQL Server 9.0.4053 - sa) |
= L{; %—-‘New Database... i Datat
B e Fots-cont

= 3 53CUfit¥ Restore Database...

® [ Server ¢ Restore Files and Filegroups...

# [ Replicat MName

# [ Manage Refresh |1 System Datab:
[ Database Snaj

[ IR N S P R 1 S S |
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Select a detached database file (Bio9000.mdf) by [Add]
button.

® Attach Databases
f;-;»ga"gml 5 Seript ~ I Help
Databases to attach:
MDF File Location Database.. AttachAs  Owner  Status | Message
Database details:
Original File Name File Type | Current File Path Message
Server:
192,168.10.48
Connection:
sa
2 View connection properties
Ready

Click [OK] then all work done.

Database could be restored by (7) process with database
which is made in (6).
(Bio9000 DB should be deleted before restoring)

nIf the modification and deletion of a user is unabled in the
terminal
If the terminal is connected with the Bio9000 For the
modification and deletion or terminal user, a use with the
authority of user management, not an authority of regular
user the Bio9000, more than power user is required.
As the user in Bio9000 is changed by changing the user in
terminal, the authority of Bio9000 is required.

ROSSILNR=

SECURITY PRODUCTS



Asia Pacific, Middle East, Africa

Rosslare Enterprises Ltd.

Kowloon Bay, Hong Kong

Tel: +852 2795-5630

Fax: +852 2795-1508
support.apac@rosslaresecurity.com

United States and Canada
Rosslare Security Products, Inc.
Southlake, TX, USA

Toll Free: +1-866-632-1101
Local: +1-817-305-0006

Fax: +1-817-305-0069
support.na@rosslaresecurity.com

Europe

Rosslare Israel Ltd.

22 Ha'Melacha St., P.O.B. 11407
Rosh HaAyin, Israel

Tel: +972 3 938-6838

Fax:+972 3 938-6830
support.eu@rosslaresecurity.com

Latin America

Rosslare Latin America

Buenos Aires, Argentina
support.la@rosslaresecurity.com

China

Rosslare Electronics (Shenzhen) Ltd.

Shenzhen, China

Tel: +86 755 8610 6842

Fax:+86 755 8610 6101
support.cn@rosslaresecurity.com

India

Rosslare Electronics India Pvt Ltd.
Tel/Fax: +91 20 40147830
Mobile: +91 9975768824
sales.in@rosslaresecurity.com

ROSSILNRR=

SECURITY PRODUCTS

: : o | ROHS
s/ 1SO 9001 Z
Y 20 14000 COMPLIANT

Product No.




	RosslareBio 9000 Software Manual cover apr 2019.pdf
	RosslareBio 9000 Software Manual body 080519.pdf

